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1 Introduction

This is a user guide for Qwizdom Connect.  This guide provides information and tips on
using Qwizdom Connect.

If you need assistance, please contact Technical Support.

Website www.qwizdom.com

Tech Support (253) 770-1285

Email support@qwizdom.com

Support Hours 6 a.m. to 4:30 p.m. PST

Address Qwizdom, Inc.
12617 Meridian East
Puyallup, WA  98373

http://www.qwizdom.com
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2 Getting Started

Contents of Remote Set
Q2RF, Q4RF, Q5RF, or Q6RF Remotes*
1 HID or RF Host
1 Q5RF Instructor Remote or 1 Q7RF Instructor Tablet*
1 USB Cable
1 Charger (Q5RF Instructor Remote)*
1 Multi-charger (Q5RF Remotes)*
1 Screwdriver
AA Batteries (Q4RF) or AAA Batteries (Q2RF)*
1 Remote Carrying Case
1 Quick Reference Guide
1 Software; Qwizdom Connect

*Remote types and accessories based on actual order. This device complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.
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2.1 Notice

Notices of Compliance for Qwizdom's RF Response Devices

Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.
· Consult the dealer or an experienced radio/TV technician for help.

Caution: Changes or modifications to Qwizdom's RF hardware that are not expressly
approved by Qwizdom could void the user's authority to operate the equipment.

This product is designed for the 2.4 Ghz WLAN network throughout the EC region and Switzerland with restrictions in France.
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2.2 Installing Qwizdom Connect

System Requirements
Windows XP 1Service Pack 2, Vista or later

Microsoft PowerPoint® 2003 or later (registered version)

Microsoft Excel® 2003 or later (registered version)
Microsoft .NET Framework 3.5 (included in installer)
Microsoft .NET Framework 3.5 SP1 (included in installer)
Intel Pentium 233-MHZ or faster processor (Pentium III recommended)
1G of RAM
5 GB of disk space
CD-ROM drive
Open USB Port

Installing Qwizdom Connect from CD
If you have the RF Host (red host), plug the USB cable into the RF Host and then plug the
other end of the USB cable into an open USB port before installing Qwizdom Connect. The
USB Drivers are located in the Qwizdom Connect installer and should auto-install if it
detects the RF Host. If not, see Installing USB Drivers to manually install USB Drivers.

1. Before installing, please check System Requirements (see above).

2. Close all Microsoft® Office and/or Qwizdom Programs.
3. Insert the Qwizdom Connect disc into the CD-ROM drive, follow the Installation

Wizard.
4. Click Next.  The Select Installation Folder  window appears.
5. You have the option to select the location where you would like Qwizdom Connect

to be saved or use the default location.
6. Click Next to begin the installation.  This will take a few moments.
7. Once the installation is complete, click Close and restart your computer.
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2.3 Online Registration

Registration must be completed in order to use any of Qwizdom Connect's online features.

1. Check to see if there is a Safe Senders List and add @qwizdom.com. If not, after you
register, check your Junk or Spam folder for emails sent by Qwizdom.

2. Click on the Qwizdom Connect icon on the desktop. Qwizdom Connect will open.
3. Go to the Login menu. This brings up the Qwizdom Online Login window.
4. Click on New User. This will bring you to the Online Registration form. Fill out the

required fields and click Submit.
6. You will receive an email with your username and password.
7. In Qwizdom Connect, go to the Login menu.  Login to Qwizdom Online with your

username and password.
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2.4 Hardware Setup

1. Q2 Remotes-place two AAA batteries and insert the screw (optional) into the back
of the remote.

2. Q4 Remotes-place two AA batteries and insert the screw (optional) into the back
of the remote.

3. Q5 Remotes-plug the Q5RF participant and instructor remotes into the multi-
charger and/or single charger for 24 hours
before first use.

5. Q6 Remotes-place two AA batteries and insert the screw (optional) into the back
of the remote.

6. Q7 Presenter Tablet-the tablet needs to be charged a full 24 hours for the first
time or after a long period of inactivity. The pen may take slightly longer to fully
charge. Generally, the tablet will only need to be charged about 6 hours to be fully
charged after the initial charge. To charge the pen and tablet, place the pen into
the pen tray located at the top of the Q7RF Tablet. Using the USB cable, plug the
tablet into the computer. The battery icon will be full when the tablet is fully
charged.

   If your computer goes into power saving mode, the charging of the Q7RF
Tablet may be interrupted.

Installing the HID (Black) Host

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

1. The HID Host is located in the back compartment of the Q7RF Tablet or in the front
pocket if remote bag.

2. Plug the HID Host into an open USB port on the computer.
3. The computer will automatically detect and configure the new hardware device.
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Installing the RF (Red) Host

 The USB Drivers are located in the Qwizdom Connect installer and should auto-install if it
detects the RF Host. Plug the USB cable into the RF Host and then plug the other end of
the USB cable into an open USB port before installing Qwizdom Connect. If drivers do not
automatically install, see Installing USB Drivers to manually install USB Drivers.
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3 Remote Setup

Follow the steps below to set up remotes.  Be sure the HID or RF host* is properly installed
before proceeding (see Hardware Setup for details). * v.938 host or higher is required for Qwizdom
Connect.  If the host is not v.938 host or higher, please contact Technical Support.

1. Click the Remotes menu. This brings up the Remote Configuration Settings window.

· Estimated Maximum Number of Remotes-the number of remotes that will
be in use for presentation.  Class/group sizes vary, so it's best to enter the
highest estimated amount of remotes rather than accommodating each
class/group.

· Enable Backlight-activates the back light on the Q5RF participant and Q5RF
Instructor Remotes.

· Fixed Set-select this mode if you are K-12 or Corporate setting. Assigning
fixed numbers assigns the remote ID (e.g. remote #1, remote #2, etc.).  The file
that contains the remote assignments is saved onto the computer, not on the
remotes.  Logging in by ID is not mandatory.

· Roaming Set or Participant Owned-check this option if the participants own
the remotes. This mode is best-suited for Higher Ed/University settings.
Participants are required to either enter a Session ID or Participant ID to join a
presentation (see Remote Login  for details.)

2. Enter an estimated number of remotes that will be used.
3. (Optional) Check the Enable Backlight on Q5 Remotes box.
4. K-12 or Corporate Settings (Recommended)- Select Fixed Set. If your remote set
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is shared among several classrooms and used with different computers, you will
need to assign fixed numbers once on each computer. Assigning fixed numbers
(remote IDs) to Qwizdom remotes saves users time by allowing the remotes to be
reused with minimal effort in future sessions. The IDs are stored inside the
computer; therefore they will ONLY need to be reassigned each time that the
remotes are moved to a new computer or host.

· Click Assign.  The Remote Assignment window opens.
· Click the Host drop-down menu and select the COM number (of the host) you

will be using. The Session ID will automatically appear in the Session ID field.
For more information on Session IDs see  below.

· Click Start.
· Turn on the remotes and enter the Session ID.  When the remotes

communicate with the host, the number of the remote (with a remote
image) appears in the window.  The Remote ID will also appear on the
remote. (Note: If remotes have been labeled with numbers, turn on remotes in
sequence. Be sure to wait until the remote has connected the host before turning
on the next remote.)

· After all the remotes have been assigned, click Stop. Click OK to save and exit
the Remote Assignment window.

· Click OK to save and exit the Configuration Settings window.

Higher Ed/University Settings (Recommended)- select Roaming Set or
Participant Owned. Click OK to save and close window.

What is a Session ID?
When using RF Remotes for the first time, the remotes may ask for a Session ID.  Each host
has a unique six-digit Session ID. Session IDs "assign" the remote to the host, allowing the
remote to only communicate with that specific host.

The Session IDs can be found:

· For both HID and RF Host, the Session ID can be found in the Remote Assignments
window, the Login tab in the Presentation Setup window, and the Login tab during
a presentation in the Qwizdom Toolbar.

· For the HID (Black) Host, click  Qwizdom Tools, found in the lower right hand
corner of the Windows Taskbar (next to the clock). The Session ID will be displayed
at the top of the menu.

· For the RF (Red) Host, the Session ID can be found on the bottom of the device on
a white sticker.

You can also create your own Session ID in the Presentation Setup window. Creating your
own Session ID does not change the host's default Session ID. The Session ID must be unique
because if there are other hosts in the same building, the remotes will become confused
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about the host with which they are to communicate.

Changing Session IDs
If the RF remote or Tablet displays No Net, Not Found, Not Active, or Inactive, it could be that
the Session ID is not correct.

· For Q2RF remotes: wait for the remote to time out and turn off. When you turn it
back on, press the Help key. When you see --S on the display, it is prompting you for
the Session ID. Enter it and press the Join key to confirm.

· For Q4RF remotes: press the Menu key, use the right arrow to scroll to Sess. ID., and
press the Send (double arrows) key to select the option.  You will see the current
Session ID and will be asked if you want to change the Session ID.  Press T (Yes) to
change.  Enter the Session ID and press the Send key to send.

· For Q5RF remotes: wait for the remote to display No Net, Not Active, or Not Found.
Press the Menu key and select Enter Session ID. Using the Send (double arrows) key or
the circle key on the thumb pad, enter the Session ID and press the Send key.

· For Q6RF remotes: press the Menu key, scroll to Enter Session ID, press the  Menu
Select key, reenter the Session ID, and press the Search Again key.

· For Q7 Tablet:  press the Menu key and use the Scroll button to scroll to Enter Session
ID. Press the Enter key to select, use the A button to delete the Session ID and then
reenter the Session ID. Press the Enter key to confirm.
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3.1 Notice

FCC 15.19:

(3)  All other devices shall bear the following statement in a conspicuous
location on the device.

This device complies with Part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

FCC 15.21:

The user's manual or instruction manual for an intentional or unintentional
radiator shall caution the user that changes or modifications not expressly
approved by the party responsible for compliance could void the user's
authority to operate the equipment. In cases where the manual is provided
only in a form other than paper, such as on a computer disk or over the
Internet, the information required by this section may be included in the
manual in that alternative form, provided the user can reasonably be
expected to have the capability to access information in that form.

FCC 15.105:

(b) For a Class B digital device or peripheral, the instructions furnished the
user shall include the following or similar statement, placed in a prominent
location in the text of the manual:

NOTE:  This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is not guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

-- Reorient or relocate the receiving antenna.
-- Increase the separation between the equipment and receiver.
-- Connect the equipment into an outlet on a circuit different from that to
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which the receiver is connected.
-- Consult the dealer or an experienced radio/TV technician for help.
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3.2 Q2RF

Participant Remote
1. E inkä display-displays the remote's ID

number when it is turned off; displays
remote's ID number and battery icon when it
is turned on.

2. Navigation  arrows-to scroll

through question numbers. Left arrow 
is also used as a backspace.

3. True/Yes, False/No keys-use to answer
True/False and Yes/No questions

4. Multiple Choice and Numeric keypad-
answer multiple choice and numeric
questions (with single digit answers).

5. Join  key-press to turn remote on/off or
confirm Session and/or User IDs.

6. Help  key-press to request assistance or
press to change Session ID when the remote
cannot find the host.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Q2 Common Screen Displays

_ _ S : Enter Session ID. See Remote Setup for details.
_ _U : The remote is asking for a Participant ID. This applies to remotes  configured for

Roaming Set or Participant Owned. See Remote Setup for details.
_ _ A : Displays when the remote is requesting an Answer Key activity number. Prompt

only appears when multiple test versions are being presented. Activity numbers
should be noted on the test sheets before presenting; numbers cannot be
viewed while in presentation mode.

- - -  :  Remote cannot find host and will power down.
 -  -  :  Remote is searching for the host.

    :  Battery icon indicates battery charge when remote is on.
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3.3 Q4RF

Participant Remote

1. Send  key-press to submit answer or
select menu options.

2. Menu [power] key-press to view menu

options (use the scroll  keys to

scroll through options and press Send 
key to select the option).  Holding the Menu
key for two seconds will turn the remote
on/off.  Turn off remotes if they are not in
use.  Remotes automatically turn off at the

end of a PowerPoint® presentation.  Search,
Sess. ID, User ID, and Exit are options available
in the Menu.  When you're in presentation,
the menu items are Help, Login, User Id, and
Exit.  To request help during presentation,
press the Menu key, scroll to select Help, and

press the Send  key to select it.

3. Scroll  keys-scroll through menu
options, answer choices, or question
numbers.

4. Clear [C] key-press to delete response or
change answers if instructor has enabled the
feature.

5. True/Yes and False/No keys--use to answer
True/False and Yes/No questions

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Q4 Common Screen Displays
· Qwizdom: Remote has found the host and is ready for a question slide.
· Activity ID: Displays when the remote is requesting an Answer Key activity number.

Prompt only appears when multiple test versions are being presented. Activity
numbers should be noted on the test sheets before presenting; numbers cannot be
viewed while in presentation mode.

· Sess. ID: Your remote may ask you to enter the Session ID. See Remote Setup for
details.

· User ID:  The remote is asking for a Participant ID. This applies to remotes  configured
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for  Roaming Set or Participant Owned. See Remote Setup for details.
· Loading: An Answer Key is loading; may take a few moments.
· Push Key: Remote is idle. Press any key, (except MENU) to reactivate.
· Inactive: Remote senses the host is not in use or does not recognize the session. If

remote remains inactive after starting a presentation, reenter Session ID by pressing
MENU, scrolling right to "Sess.ID," and pressing SEND. When prompted, reenter the
Session ID and press SEND.

· No Net: Remote cannot find the host. Reenter the Session ID. If "No Net" continues,
enter User ID and Session ID.

· Denied: User denied due to incorrect User ID or a duplicate User ID. Reenter User ID.
Press MENU, scroll to "User ID," press SEND, enter the User ID, and press SEND again.
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3.4 Q5RF

Participant Remote

         
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

1. Send  key-press to submit answer.
2. Clear [C] key-press to delete response or change an answer in a presentation (if

option to change responses is allowed).
3. Thumb pad-press to navigate between letters when keying in answer, press the

circle key in the middle to select a letter or to select menu options or to scroll
through question numbers during answer keys (paper-based tests).

4. Question [?] key-signals help to instructor during presentation.
5. Menu key-displays menu options Search Again, Enter Session ID, and Exit.  Use the

thumb pad to scroll through the menu options and the Send  key or circle key
to select an option.

6. True/Yes and False/No keys-use to answer True/False and Yes/No questions.
7. Power switch-turns remote on/off.  The remotes do not automatically turn off.

Turn off remotes if they are not in use.
8. Backlight switch-turns Backlight on/off.
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Q5RF Instructor Remote

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

1. Send  key-press to submit command.
2. C [Clear] key-press to clear names from the Help Request list.
3. Thumb pad-press right/left to navigate between slide sets, up/down for menu

options, and "on-the-fly" question choices.  Press the circle key (in the middle) to

select an option, play Microsoft PowerPoint® animations, advance slides, exit the
presentation, and show/hide correct responses on the response graph.

4.   ? [Help List] key-displays list of participants who requested help on the LCD
screen.

5. Menu key-view menu options such as entering Session ID and search again for
host.

6. True/Right and False/Wrong keys-not applicable using Qwizdom Actionpoint.
7. New Q [-] key-press to pose an "on-the-fly" question.
8. Pick [.] key-press to display/hide a random participant's name on the computer

screen.

9. Private Graph  [0] key-displays the results of participant responses as a graph on
the LCD screen of the instructor's remote.

10. Public Graph  [/] key-displays the results of participant responses as a graph
on the computer (projector, television screen, etc.) screen for everyone to view.
Use the right/left controls on the thumb pad to scroll through the different graphs.
Use the circle key (in middle of thumb pad) to show/hide correct responses.

11. Show [7] key-displays animations during game presentations.
12. Play [8] key-will play animation/sound in Connect only.
13. Fn (Function) key-allows you to re-pose a question if you go back during to a
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previous slide during presentation-previous answers will be overwritten.
14. Power switch-turns remote on/off.
15. Light switch-turns Backlight on/off.  The "Enable Backlight" box in the Configuration

Settings window needs to be checked to turn on the         Backlight feature.

Q5RF Common Screen Displays
· Qwizdom: Displays when slides are non-question types, such as lessons or

information.
· Activity ID: Displays when the remote is requesting an Answer Key activity number.

Prompt only appears when multiple test versions are being presented. Activity
numbers should be noted on the test sheets before presenting; numbers cannot be
viewed while in presentation mode.

· Loading: An answer key is loading; may take a few moments.
· Push Key: Remote is idle. Press any key, (except MENU) to reactivate.
· Inactive: Remote senses the host is not in use or does not recognize the session. If

remote remains inactive after starting a presentation, reenter Session ID by pressing
MENU, scrolling right to "Sess.ID," reentering Session ID, and pressing SEND.

· No Net: Remote cannot find the host. Reenter the Session ID. If "No Net" continues,
enter User ID and Session ID.

· Denied: User denied due to incorrect Session ID, User ID, or a duplicate User ID.
· Ready: Displays on the instructor remote is ready to use.
· Last Key: Will appear on the instructor's remote showing the last key that was

pressed.
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3.5 Q6RF

Participant Remote
1. Menu/Power-press and hold on to power

remote on/off. Press to view menu options:
Help, Search, Sess. ID, User ID, Adjust Contrast,
and Exit.

2. Enter-press to submit commands from LCD
menu choices.

3. Directional Arrows-press to navigate
between menu options, answer choices, and
questions.

4. Multi-function-serves as multi-function for
Send/Change.

5. Symbols-select to enter fraction,
punctuation, etc.

6. Delete-press to delete the last character.
7. Q#-displays the current question number.
8. Help Request-indicates your requested help.
9. Battery Power-displays battery charge.
10. ID#-displays the remote ID number.
11. Right/Wrong Feedback-displays check mark

for correct answer, X for incorrect answer,
and both check mark/X for response
received.

12. Shift-changes case options:
ABC/Abc/abc/123/Superscript/Subscript.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Q6 Common Screen Displays

· Searching for Session ID: Remote is searching for the host.
· Ready: Remote has found the host and is ready for a question slide.
· Power Save Mode: Remote is idle. Click RESUME, to reactivate.

· Help: First available Menu option. With Help selected, press the menu select key 

to privately ask for help or scroll to "EXIT" and press .
· Session ID Not Found: Remote cannot find the host. Re-enter the "Session ID." Press
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MENU, scroll to "Enter Session ID," click� , enter the Session ID, and press JOIN.
Session ID Login Denied: User denied due to incorrect User ID, or a duplicate ID. Re-

enter User ID. Press MENU, scroll to "Enter User ID," click  , re-enter the User ID,
and press JOIN.

· Enter User ID: The remote is asking for a Participant ID. This applies to remotes
configured for  Roaming Set or Participant Owned. See Remote Setup for details.

· Loading: Loading an Answer Key; may take a few moments.
· Enter Activity ID: Requesting an Answer Key activity number. Prompt only appears

when multiple test versions are being presented. Activity numbers should be noted
on the test sheets before presenting; numbers cannot be viewed while in
presentation mode.

To send question text to Q6RF remotes click on the  Advanced
Options button and check the Send Question Text to Remotes box. This
option is set per questions slide if desired. See Creating Slides for details.
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3.6 Using Remotes in Presentation

Q5RF Instructor Remote Tips
· The Q5RF Instructor Remote will display Ready or Last Key.

· Since the Q5RF Instructor Remote is not applicable during answer keys, the LCD
screen will display Access Denied.

· Press the / key on the Q5RF Instructor Remote to display the response graph.

· Press the / key on the Q5RF Instructor Remote to close the response graph.

· Press the 0 key on the Q5RF Instructor Remote to display the graph on the
instructor's LCD.

· Press the Pick (.) key on the Q5RF Instructor Remote to randomly call upon a
participant during presentation.

· Press the 1 (A) key on the Q5RF Instructor Remote to go to the next question in Fast
Track/Mars Mission games.

· Press the Show (7) key on the Q5RF Instructor Remote to show current scores of
participants/group during game mode.

· Press the New Q (-) key to pose a spontaneous question. A list of question types
appear on the LCD. Use the up/down arrows on the thumb pad to navigate
through the question types. Press the Send key to select the question type. Select
the correct answer and press Send; if the answer is survey only, press the Send key
without selecting an answer.

· Press the ? key to display the list of participants who have requested help.

· Press the circle key, in the thumb pad, to close out of the presentation (must be on

last slide), play the PowerPoint® animation and schemes (if any were applied), move
to the next slide, or display/hide the correct answer on response graph.

Participant Remote Tips
· Remotes's displays will vary when they are Ready to Start an

activity/presentation.
Qwizdom will be displayed on the Q4RF and Q5RF remotes when a lesson (non-
question) slide is in view. Ready will be displayed on the Q6RF remotes  have found
the host and are ready for a question slide.



Qwizdom Connect User Guide25

Qwizdom Connect 2010

· Remotes' displays will vary during an activity/presentation.
For Q2RF remotes, participants will see a blank screen with a battery icon. For Q4RF
and Q5RF remotes, participants will either see answer choices or a blank screen
(depending on question type) on their remote during a question slide. For Q6Rf
remotes, question text and/or answer choices will appear on the LCD screen
(display varies depending on question type). See Creating Slides for information
on setting up the different question types.

· Request Help-
For Q2RF remotes, press the Help (Hand) key. To request help on the Q4RF, Q5RF
and Q6RF remotes, press the Menu key to select Help and press Send.

· Change Session ID-
To change the Session ID on the Q2RF remote, when the remote is on, wait for the
remote to time out and turn off. When you turn it back on, press the Help key.
When you see --S on the display, enter the Session ID and press the Send key to
confirm.

To change the Session ID on the Q4RF remote, press the Menu key and use the
right arrow to scroll through the menu options. When you see Sess. ID, press the
Send key to select it. An existing Session ID may appear and the remote will ask if
you want to change it. Press T for yes and enter the new Session ID. Press the Send
key to confirm.

To change the Session ID on the Q5RF remote, press the Menu key when the
remote displays No Host Found. Use the thumb pad to navigate through the menu
options and press the Send key to select Enter Session ID.

To change the Session ID on the Q6RF remote, press the Menu key, scroll to Enter

Session ID, press the  menu select key, re-enter the Session ID, and press the
Search Again key.

· Troubleshooting Tips-

The Q4 LCD screen on the participant remotes may read Push Key, Inactive, Not Active,
press the Send (double arrows) key to "wake up" the remote.  If the remote still
displays Not Active, re-enter the Session ID. Go to Changing Session IDs for more
information.

The Q6 LCD screen on the participant remotes may display Power Save Mode. This
indicates that the remote is idle. Click RESUME, to reactivate.

If the Q4RF displays No Net, or the Q5RF remote displays Host not found, Session ID
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Not Found, or the Q2RF remote displays - - - and turns off, re-enter the Session ID.  Go
to Changing Session IDs for more information.

If the Q4RF remote displays Denied, or the Q5RF remote displays Access Denied, or the
Q6RF displays Session ID Login Denied, or the Q2RF remote displays --U, the Participant
ID is incorrect, or the Remote ID attempting to participate isn't in the participant list
that was loaded.  re-enter the Participant ID, and check to make sure that Remote ID is
in the participant list.

Below are the procedures on how to respond for each question type during
presentation for Q2RF, Q4RF, and Q5RF remotes:

· True/False-press  T or F key and then press the Send key.

· Yes/No-press  Y or N key and than press the Send key.

· Multiple Choice-press A, B, C, D, E, or F and then press the Send key.

· Multiple Mark-select multiple letter choices and than press the Send key.

· Numeric-enter the numbers and than press the Send key.

· Sequence-enter the numbers in the correct order and press the Send key.

· Short Text Response; for Q5 remotes only. The alphabet menu will automatically
appear when this question type is displayed. Use the arrows on the thumb pad to
navigate through the letters, using the Circle key to select the letter(s). Press the
Send key to confirm your answer.

Below are the procedures on how to respond for each question type during
presentation for Q6RF remotes:

· True/False-use down arrow to scroll to T or F and then press the Send key.

· Yes/No-use down arrow to scroll to Y or N and then press the Send key.

· Multiple Choice-use down arrow to scroll to A, B, C, D, E, or F and then press the
Send key.

· Multiple Mark-use down arrow to scroll to answer choice, click the  Menu Select
key to select multiple answer choices, and then press the Send key.
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· Numeric-enter the numeric answer and then press the Send key.

· Sequence-enter the numbers in the correct order and then press the Send key.

· Short Text Response-enter in the appropriate answer and then press the Send key.

· Text Response-enter in the sentence/s answer and then press the Send key.

· Text Edit-use directional arrows to scroll to the text that needs editing, press Delete
to remove incorrect character/s, enter correction, and press the Send key when
finished.

· Equation-enter the numeric answer (add special characters by pressing the Sym
button) and then press the Send key.
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4 Q7RF Tablet

Instructor Tablet

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The active area of the Q7RF Instructor Tablet acts as an absolute position mouse or
standard mouse, controlling standard keyboard shortcuts such as:

· copy, paste, and delete
· navigating presentations



Qwizdom Connect User Guide29

Qwizdom Connect 2010

File Browser-opens file browser
window

Stop-stops the question being posed

New Item-creates new slide, file, or
document depending on application
(acts like Control + N)

Private Graph-displays private graph of
responses on tablet (See
Response Graph for details.)

Open-browse and open files (acts
like Control + O)

Public Graph-displays response graph
to participants (See Response Graph for
details.)

Copy-copies selected object(s) (acts
like Control+C)

LCD Backlight-turns Backlight on or off

Paste-pastes copied object(s) (acts
like Control+V)

 Pen tool-use to draw

Undo-undo last action(s) (acts like
Control+Z)

Highlighter-use to highlight

Redo-redo previous action(s) (acts
like Control + Y)

Line tool-use to draw lines

Delete-deletes selected object(s) Text tool-use to create text

Media Control-play and pause
presentations and multimedia files

Insert Multimedia-inserts images,
audio, and video files

Pick-picks random participants Window Shade-hides portion of
displayed screen

Show Presentation-displays image
or presentation or game window

Laser Pointer-displays laser dot when
using the Pen

Help Requests-privately displays list
of participants who requested help

Absolute Position Mouse-displays
arrowhead when using the Pen and
works as an absolute position mouse

Insert Slide-creates slides for
presentation (See
Posing Spontaneous Questions for
details. )

Mouse-operates pen with mouse
functions as it changes to standard
mouse mode from absolute position

Pose-re-poses current question slide Keyboard tool-activates keyboard
region

Time tool-adds additional time to
timer

Function tool-lock/unlock functions for
freehand. Access user-defined list of
functions
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  Volume Control

Quick Pose Controls (See Posing Spontaneous Questions for details)

  For Numeric question types

 For Multiple Choice question types

 For Rating question types

 For Yes/No or True/False question types

Pen (for Q7RF Instructor Tablet)

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The Pen is used as a mouse that can left-click, right-click, and double-click to execute
commands and actions on the Q7RF Instructor Tablet.

HID Host (for Instructor Tablet)

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The USB Host is used to collect data from the remotes and record into the Qwizdom
software. This HID Host does not require driver installation.
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4.1 Using the Q7RF Tablet

 New Item-creates new slide, file, or document depending on application

Open-browse and open files

 File Browser-opens file browser window

 Copy-copies selected object(s)

 Paste-pastes copied object(s)

 Delete-deletes selected object(s)

Pose-poses question slide

 Insert Slide-creates slides for presentation

 Stop-stops the question being posed

 Window Shade-hides portion of displayed screen

You must be in Presentation Mode to utilize the features on the Tablet.
Creating Slides

1. Press the New Question icon on the Tablet. A list of question types appear on the
Tablet's LCD.

2. Use the Scroll button to navigate through the different question types.
3. Select one and press Enter.
4. Use the Pen to select or enter a correct answer using the answer choices, located

at the bottom of the Tablet.
5. Draw or enter text and/or multimedia onto the slide.
6. Press the Send key to pose the question.

Window Shade
Window Shade hides (covers) what is being displayed on the computer screen (portion or

all).
1. Press the Window Shade icon on the Tablet. A window shade will cover the

computer screen.
2. Use the Scroll button to navigate through the different question types.
3. Select one and press Enter.
4. Use the Pen to select or enter a correct answer using the answer choices, located

at the bottom of the Tablet.
5. Draw or enter text and/or multimedia onto the slide.
6. Press the Send key to pose the question.
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4.2 Using the Pen

The Pen is used (with the Tablet) to write, draw, and control mouse movements.

Pen Tip-same as a mouse cursor.
Left-click button-same as double-clicking with left button on the mouse.
Right-click button-same as the right-click button on the mouse.

Pen Actions
· Press, Tap, Push Down with Pen Tip-activates Tablet icons, similar to left-clicking

with mouse.
· Double tap with Pen Tip-is similar to double-clicking with mouse.
· Left-click-activates Tablet icons, similar to double-clicking with mouse.
· Right-click-similar to right-clicking with the mouse.

Sleep Mode
The Pen goes into sleep mode after a minute of inactivity. Touching the pen to the Q7RF
Tablet surface or pressing the Left/Right buttons on the pen will reactivate it.
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4.3 Drawing and Editing Tools

 Pen Tool-use to draw

Highlighter-use to highlight

Line Tool-use to draw lines

Text Tool-use to create text

Laser Pointer-displays laser dot when using the Pen

 Absolute Position Mouse-displays arrowhead when using the Pen and works as an
absolute position mouse

 Mouse-operates pen with mouse functions

 Keyboard-activates keyboard region

Select Tool
Selects drawing and text objects such as text boxes, shapes, lines, etc.

1. Press the  Absolute Position Mouse icon on the Tablet.

Mouse
Changes the Pen to replicate the movement of a computer mouse.

1. Press the  Mouse Tool icon on the Tablet.
2. Press the Pen Tip anywhere on the Tablet's surface as if you were using a computer

mouse.

3. Select another tool or press  on the  Absolute Position Mouse to turn Pen Tool
off.

Drawing and Writing
Pen Tool is used to draw objects and write text.

1. Press the  Pen Tool icon on the Tablet.
2. Place the Pen Tip on the Tablet's surface to draw or write with the Pen Tool.

3. Select another tool or press the  Absolute Position Mouse to turn Pen Tool off.

Highlighting
Highlighter Tool is used to highlight text and/or objects.

1. Press the  Highlighter icon on the Tablet.
2. Place the Pen Tip onto the Tablet's surface to highlight text and/or objects.

3. Select another tool or press the  Absolute Position Mouse to turn Highlighter off.
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Entering Text
The combination of the Text Tool and Keyboard allows you to create text without the use of
the Tablet's keyboard.

1. Press the  Text Tool icon on the Tablet.
2. Use the Pen to create a text box on the computer screen by touching the Pen Tip

onto the Tablet surface and drawing out the text box.

3. Press the  Keyboard icon on the Tablet to activate the keyboard region.
4. Use the Pen Tip to enter the text into the text box using the keyboard on the

Tablet.

5. Press the  Absolute Position Mouse to deactivate the keyboard region on the
Tablet.

Drawing Lines
Draws straight lines with or without arrowheads.

1. Press the  Line Tool icon on the Tablet.
2. Place the Pen Tip onto the Tablet's surface to draw a line.

3. Select another tool or press the  Absolute Position Mouse to turn Line Tool off.

Laser Pointer
Changes the computer cursor into a laser pointer.

1. Press the  Laser icon on the Tablet.
2. Place the Pen Tip onto the Tablet's surface to activate the laser.

3. Select another tool or press the  Absolute Position Mouse to turn Laser Pointer
off.
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4.4 Wizteach Tools

Wizteach tools is set by default to activate when using the drawing and editing tools on
the Tablet using Qwizdom Tools, Actionpoint, and outside of Qwizdom Connect.

1. Press any one of the drawing tools on the Tablet with the Pen.

                       
2. The drawing tools menu appears on the computer screen.

· Select: selects objects
· Undo: removes last action
· Draw: use to draw
· Line: creates lines
· Erase: erases selected objects
· Shape: creates shapes
· Text: adds a text box to create text (using the Keyboard feature on the Tablet)
· Color: color palette
· Highlighter: use to highlight objects on screen
· Capture: use to take screen captures of current screen

Select Tool
Use to select drawing and text objects such as text boxes, shapes, lines, etc.

1. Click the  Pointer to activate the selecting tool.
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Undo

1. Click the  Undo to undo the last action(s).

Drawing and Writing

1. Click the  Draw tool.
2. Place the Pen Tip on the Tablet's surface to draw or write with the Draw tool.

3. Select another tool or press the  Pointer to turn Draw tool off.

Drawing Lines
Draws straight lines with or without arrowheads.

1. Click the  Line tool.
2. Place the Pen Tip onto the Tablet's surface to draw a line.

3. Select another tool or press the  Pointer to turn Line tool off.

Eraser

1. Click the  Eraser tool.

2. Select to erase a certain object , erase the selected area , or erase all

objects .

2. Select another tool or press the  Pointer to turn Eraser off.

Shapes
Creates basic shapes such as square, triangle, circle, and free form.

1. Click the  Shapes tool.
2. Place the Pen Tip onto the Tablet's surface to create and add a shape.

3. Select another tool or press the  Pointer to turn Shapes tool off.

Entering Text
The combination of the Text Tool and Keyboard allows you to create text without the use of
the Tablet's keyboard.

1. Click the  Text tool.
2. Use the Pen to create a text box on the computer screen by touching the Pen Tip
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onto the Tablet surface and drawing out the text box.

3. Click the  Keyboard icon on the Tablet to activate the keyboard region.
4. Use the Pen Tip to enter the text into the text box using the keyboard on the

Tablet.

5. Click the  Pointer to deactivate the keyboard region on the Tablet and click the

 Pointer to turn Text tool off.

Highlighting
Highlighter Tool is used to highlight text and/or objects.

1. Click the  Highlighter.
2. Place the Pen Tip onto the Tablet's surface to highlight text and/or objects.

3. Select another tool or press on the  Pointer to turn Highlighter off.

Color Palette
Color palette is used to set the color of drawing objects that will be created.

1. Click the  Color Palette.
2. Select the color that will be applied to the drawing object.

3. Click the X in the color palette to close the color palette.

Capture
Takes a full-screen capture of the current screen.

1. Press the  Capture icon on the Tablet.
2. The Save As window appears.
3. Enter the name for the screen capture and click Save.



Q7RF Tablet 38

Qwizdom Connect 2010

4.5 Speaker Notes

Speaker notes allow you to view notes on the Q7 Tablet while in presentation mode.

1. Select a slide to place speaker notes on.
2. Click Settings.
3. Select Speaker Notes. The Speaker Notes window appears.

4. Click Insert at Root . Root appears for you to enter text.
5. Enter text.

6. Click Insert  to insert a subroot.
7. Enter text.

8. When finished, click close to save the information.
9. Click Save to save the changes.
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5 Creating & Organizing Content

Click the Content tab; or right-click the Qwizdom Tools and select Content Manager.
Content Manager is where all created and imported activities are stored and organized.

Create a New Folder

1. Click the  New Folder button.
2. Enter a name for the folder and click OK.
3. The folder appears in the Content Tree on the left.

Create a New Activity

1. Click the  New Activity button.
2. Enter a name for the activity and click OK.
3. The activity appears in the Content Tree on the left.

4. Select the newly created activity and click the  Edit button to launch Live
Editor. See Creating Slides for more information.

Create a New Answer Key
1. Click the   New Activity button.
2. Select Create and Add Answer Key file and enter a name.
3. Click OK and the answer key appears in the Content Tree on the left.
4. Double-click the answer key file to launch the Answer Key window. See Answer Key

for more information.
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5.1 Importing and Exporting

Importing Activities (.QAP and .QZA)
1. Go to the File menu and select Import/ Qwizdom Activity. The Open window

appears.
2. Select the activity (.QAP or .QZA) and click Open. The activity will import into the

Content Tree.

You can also drag and drop activities (.QAP, .QZA, .QAK, .PPT, .PPTX) into the
Content Tree.

Importing External Documents
1. Go to the File menu and select Import/External Document. The Open window

appears.
2. Select the file you would like to import and click Open. The external document will

import into the Content Tree.

Exporting Activities
1. Select the activity in that you wish to export.
2. Go to the File menu and select Export. The Save As window appears.
3. Choose the location to which to export your file and select OK.
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5.2 Printing

1. Click on an activity in the  and click the  Print button. This brings up the Print
Activity window.

3. Set print options including number of slides per page, slide range, headers,
footers, etc  and click Print.  The activity will print.

 Under Print Type, select workspace to give students extra room to show their
work and/or answers.
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5.3 Standards

Installing Standards
1. Go to the Login menu and enter your username and password (see

Online Registration for details on how to create a username and password.)
2. Go to the File menu and select Preferences.
3. Click the Standards tab.
4. Select your state standards in the Select State drop-down list.
5. Click Download State Standards to download your state standards into Qwizdom

Connect.

Applying Standards
You can apply standards to a single slide or activity.

Apply standards to whole activity.
1. Click on the Content tab.
2. Select an activity in the Content Tree.

3. Click the  Standards button. The Standards window appears.
4. Select the standard at the level you want to apply to all of the slides in the activity.
5. Click Add and then Done.  The standards appear in the Standards tab at the bottom

of the Content Manager window.

If the Standards Properties tab isn't displayed, go to the View menu and select
Properties.

Apply standards to individual slide/s.
1. Click on the Content tab.
2. Select an activity in the Content Tree. Click on a blank slide/s in the Activity Preview

window.

3. Click the  Standards button. The Standards window appears.
4. Select the standard at the level you want to apply to the slide(s).
5. Click Add and then Done.  The standards appear in the Standards tab at the bottom

of the Content Manager window.

If the Standards Properties tab isn't displayed, go to the View menu and select
Properties.
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6 Live Editor

Create activities, lessons, and tests in styles, tools, and templates.

To open Live Editor:
· Go to the Programs menu and select Live Editor.

Live Editor can also be launched through the Content Manager. Double-click any
slide thumbnail in the Activity Preview window  located to the right of the Content
Tree.

Overview Live Editor Tools

Live Editor Window
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Editor Toolbar

Pen Tool

1. Click the  Pen tool drop-down arrow and select a Pen style.
2. If you wish to create a custom style, select Customize .  The Customize Pens window

appears.

3. Click  Add and choose thickness, color, and transparency.

Click  Delete to delete a pen style.
4. Click OK to save the pen style(s).

Line Tool

1. Click the  Line tool drop-down arrow and select a Line style.
2.  If you wish to create a custom style, select Customize .  The Customize Line window

appears.

3. Click  Add and choose thickness, color, and transparency.

Click  Delete to delete a line style.
4. Click OK to save the line style(s).

Shapes Tool

1. Click the  Shapes tool drop-down arrow and select a Shape.
2. If you wish to create a custom style, select Customize.  The Customize Shapes

window appears.
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3. Click  Add and choose thickness, color, and transparency.

Click  Delete to delete a shape.
4. Click OK to save the custom shapes.

Text Tool

1. Click the  Text tool drop-down arrow and select a Font style.
2. If you wish to create a custom  style, select Customize .  The Customize Text  window

appears.

3. Click  Add and choose font type, size, and attributes.

Click  Delete to delete the custom font.
4. Click OK to save the custom font.

Font Toolbar

To view Font toolbar either click an active text box or the   Text tool.
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Answer Toolbar - see Creating Slides for details

Question Types
· Information-non-question slide (non-remote).
· Multiple Choice-multiple choice question slide (up to six choices); use with Q2RF,

Q4RF, Q5RF, and Q6RF.
· Yes/No-yes/no question slide; use with Q2RF, Q4RF, Q5RF and Q6RF.
· True/False-true/false question slide; use with Q2RF, Q4RF, Q5RF, and Q6RF.
· Numeric-numeric question slide; single digit numeric answer allowed for Q2RF; nine

digit numeric answer allowed for Q4RF;  eight digit numeric answer allowed for
Q5RF; fourteen digit numeric answer allowed for Q6RF.

· Sequence-place item choices in the specified order; use with Q4RF, Q5RF, and Q6RF.
· Multiple Mark-this question type enables two or more correct answers (up to six

choices); use with Q4RF, Q5RF, and Q6RF.
· Rating Scale/Survey-rating/opinions/polling using scales from 1-5, 1-10, etc.; use

with Q4RF, Q5RF, and Q6RF.
· Short Text Response-answer can be up to 32 characters long; use with Q5RF and

Q6RF remotes.
· Text Response-answer can be up to 102 characters; use with Q6 RF remotes.
· Text Edit-participants are given a sentence, phrase, or item that they can correct on

the Q6RF remote.
· Equation-create questions that allows participants to respond with numeric

answers, including special characters; use with Q6 RF remotes.
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Slides Tab
Displays thumbnails of all slides in the activity.

Media Tab
Allows you to search and use images, videos, etc in the Qwizdom database.

Templates Tab
Displays slide templates.
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Styles Tab
Displays slide styles.
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6.1 Creating Slides

Click the Content tab and click  Add Live Editor File. Name the new activity. Double-click
on the blank slide in the  window to launch .

Information
Non-question slide.

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select None as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse styles by category,
and select a style. Drag and drop style onto slide. See Styles and Templates for
more details.

7. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Multiple Choice (Q2RF, Q4RF, & Q5RF)
Multiple choice question slide (up to six choices).

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Multiple Choice as the slide type.
3. Select the correct answer in the Answer field.
4. (Optional) Set the time limit and number of points.
5. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
6. Enter text onto the slide.
7. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

8. (Optional) Add custom style to slide. Click the Styles tab, browse styles by category,
and select a style. Drag and drop style onto slide. See Styles and Templates for
more details.

9. (Optional) Set partial grading options. Click the   Advanced Options button. This
will bring up the Question Properties window. Select the correct answer and enter
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multiple point values for partial grading (whole numbers only). Click OK to save
and close window.

10. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
11. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Multiple Choice (Q6RF)
Multiple choice question slide (up to six choices).

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Multiple Choice as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse styles by category,
and select a style. Drag and drop style onto slide. See Styles and Templates for
more details.

7. (Optional) Set the time limit.

8. Click the   Advanced Options button. This will bring up the Question Properties
window.

· (Optional) Check the Send Question Text to Remotes box to send questions to
Q6RF LCD screens. Questions can have a maximum of 102 characters, including
punctuation and spacing.

· In the Answer Data field, select the correct answer and enter multiple point
values  for partial grading (whole numbers only).

· Check the Send Answer Choices to Remotes box.
· Click OK to save changes and close window.

 Multiple choice answers are limited to a maximum of 15 characters. If you would
like to display answer choices on Q6RF LCD screens longer than 15 characters,
uncheck the Send Answer Choices to Remotes option. Then enter in your question
and answer choices into the Send Question Text to Remotes field, keeping in
mind that there is a 102 character limit.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank
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answer slide, click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Yes/No (Q2RF, Q4RF, & Q5RF)

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Yes/No as the slide type.
3. Select the correct answer in the Answer field.
4. (Optional) Set the time limit and number of points.
5. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
6. Enter text onto the slide.
7. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click search. Drag and drop multimedia items onto
slide.

8. (Optional) Add custom style to slide. Click the Styles tab, browse  styles by category,
and select a style. Drag and drop style onto slide. See Styles and Templates for
more details.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Yes/No (Q6RF)

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Yes/No as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse  styles by category,
and select a style. Drag and drop style onto slide. See Styles and Templates for
more details.

7. (Optional) Set the time limit.
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8. Click the   Advanced Options button. This will bring up the Question Properties
window.

· (Optional) Check the Send Question Text to Remotes box to send questions to
Q6RF.  Questions can have a maximum of 102 characters, including
punctuation and spacing.

· Select the correct answer and enter the number of points.
· Click OK to save changes and close window.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

True/False (Q2RF, Q4RF, & Q5RF)

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select True/False as the slide type.
3. Select the correct answer in the Answer field.
4. (Optional) Set the time limit and number of points.
5. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
6. Enter text onto the slide.
7. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

8. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

True/False (Q6RF)

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select True/False as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the
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template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

7. (Optional) Set the time limit and number of points.

8. Click the   Advanced Options button. This will bring up the Question Properties
window.

· (Optional) Check the Send Question Text to Remotes box to send questions to
Q6RF. Questions can have a maximum of 102 characters, including punctuation
and spacing.

· Select the correct answer and enter the number of points.
· Click OK to save changes and close window.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create blank

answer slides click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Numeric (Q2RF, Q4RF, & Q5RF)
Numeric question slide. Single digit numeric answer allowed for Q2RF; eight digit numeric
answer allowed for Q4RF; ten digit numeric answer allowed for Q5RF; 14 digit numeric
answer allowed for Q6RF.

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Numeric as the slide type.
3. Type numeric answer in Answer field .
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4. (Optional) Set partial grading options. Click the Advance Options button. This
brings up the Question Properties window. Enter the answer/s and point value/s.
Click OK to save and close.

· Numeric - Select Numeric to add in standard numeric answer/s. (Optional)
Enter in multiple answers and point values to give students partial credit.
(Optional) Check the Convert fractions to numbers box to allow both fraction
and decimal answers  to be counted as correct. If this box is unchecked only
the answer that is typed into the above field will be counted as correct.

· Numeric Range - Select Numeric Range to add an answer for rounding,
number set, algebraic and other problems with a varying answer range.
(Optional) Check the Require Precision to box and select a place value from
the drop-down menu.

5. (Optional) Set the time limit.
6. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
7. Enter text onto the slide.
8. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

9. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

10. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the
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 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
11. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Numeric (Q6RF)
Numeric question slide. Single digit numeric answer allowed for Q2RF; eight digit numeric
answer allowed for Q4RF; ten digit numeric answer allowed for Q5RF; 14 digit numeric
answer allowed for Q6RF.

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Numeric as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

7. (Optional) Set the time limit.
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8. Click the Advance Options button. This brings up the Question Properties
window. (Optional) Check the Send Question Text to Remotes box to send questions
to Q6RF. Questions can have a maximum of 102 characters, including punctuation
and spacing. Enter the answer/s and point value/s. Click OK to save and close.

· Send Question Text to Remotes-check to send question text to Q6RF
remotes.

· Numeric - select Numeric to add in standard numeric answer/s. (Optional)
Enter in multiple answers and point values to give students partial credit.
(Optional) Check the Convert fractions to numbers box to allow both fraction
and decimal answers  to be counted as correct. If this box is unchecked only
the answer that is typed into the above field will be counted as correct.

· Numeric Range - select Numeric Range to add an answer for rounding,
number set, algebraic and other problems with a varying answer range.
(Optional) Check the Require Precision to box and select a place value from
the drop-down menu.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.
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Sequence (Q4RF & Q5RF)
Place item choices in the specified order.

1. Click the New  Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list; select Sequence and number of items.
3. Type numeric answer in Answer field and press the Enter key on the keyboard to

save it.

4. (Optional) Set partial grading options. Click the Advance Options button.  This
brings up the Question Properties window. In the Answer field, type in the correct
sequence. Check the Give 1 Point for every item in the correct position box for partial
grading. Click OK to save and close.

5. (Optional) Set the time limit.
6. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
7. Enter text onto the slide.
8. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

9. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

10. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
11. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Sequence (Q6RF)
Place item choices in the specified order.

1. Click the New  Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list select; Sequence and number of items.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.
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7. (Optional) Set the time limit.

8.     Click the Advance Options button.  This brings up the Question Properties
window. (Optional) Check Send Question Text to Remotes to send question text to
Q6RF remotes. Questions can have a maximum of 102 characters, including
punctuation and spacing. Enter the answer and point value. (Optional) Check the
Give 1 Point for every item in the correct position box for partial grading. Click OK to
save and close.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Multiple Mark (Q4RF & Q5RF)
This question type enables two or more correct answers (up to six choices).

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Multiple Mark as the slide type.
3. Enter the correct answers in the Answer field and press the Enter key on the

keyboard to save it.

4. (Optional) Set partial grading options. Click the Advance Options button.  This
brings up the Question Properties window. In the Answer Data field, select the
correct answers.  Set the number of points. Check the Give 1 Point for every item in
the correct position box to give participants partial credit for every correct answer
entered. Click OK to save and close.
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5. (Optional) Set the time limit.
6. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
7. Enter text onto the slide.
8. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

9. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

10. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
11. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Multiple Mark (Q6RF)
This question type enables two or more correct answers (up to six choices).

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Multiple Mark as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

7. (Optional) Set the time limit.
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8. Click the Advance Options button.  This brings up the Question Properties
window.

· (Optional) Check the Send Question Text to Remotes box  to send questions to
Q6RF LCD screens. Questions can have a maximum of 102 characters, including
punctuation and spacing.

· In the Answer Data field, select the correct answers. Set the number of points.
Check the Give 1 Point for every item in the correct position box to give
participants partial credit for every correct answer entered (whole numbers
only).

· Click OK to save changes and close window.
9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Rating Scale / Survey(Q4RF & Q5RF)
Rating scale question slide (i.e. rating/opinions/polling using scales from 1-5, 1-10, etc.).

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Rating Scale as the slide type.
3. (Optional) Type in answer in the Answer field.
4. (Optional) Set the time limit and number of points.
5. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
6. Enter text onto the slide.
7. (Optional) Add multimedia such as images, movies, and sound. Click on the Media
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tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

8. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Rating Scale / Survey (Q6RF)
Rating scale question slide (i.e. rating/opinions/polling using scales from 1-5, 1-10, etc.).

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Rating Scale as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

7. (Optional) Set the time limit and number of points.

8. (Optional) Send questions to Q6RF. Click the Advanced Options button. This
brings up the Question Text window. Check the Send Question Text to Remotes box.
Questions can have a maximum of 102 characters, including punctuation and
spacing. Click OK to save and close the window.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Short Text Response (Q5RF)
Answer can be up to 32 characters long on the Q5RF remote.

1. Click the  New Question button.  A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.
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2. Click the Type drop-down list and select Short Text Response as the slide type.
3. Click the Answer field, type in answer, and press enter when finished.
4. (Optional) Set time limit and number of points.
5. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
6. Enter text onto the slide.
7. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

8. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

9. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
10. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Short Text Response (Q6RF)
Use this question type for fill-in-the-blank and/or any other short answer questions.

1. Click the  New Question button.  A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Short Text Response as the slide type.
3. Click the Answer field, type in answer, and press enter when finished.
4. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
5. Enter text onto the slide.
6. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

7. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

8. (Optional) Set time limit and number of points.

9. (Optional) Send questions to Q6RF. Click the Advanced Options button. Check
the Send Question Text to Remotes box. Questions can have a maximum of 102
characters, including punctuation and spacing. Click OK to save and close the
window.

10. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
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11. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.
12

Text Response (only applicable to Q6RF)
Answer can be up to 102 characters on the Q6RF remote.

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Text Response as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
5. Enter text onto the slide.
6. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click Search. Drag and drop multimedia items onto
slide.

7. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

8. (Optional) Set the time limit.

9. Click the  button. This brings up the Question Properties window.

10. (Optional) Send questions to Q6RF. Check the Send Question Text to Remotes box.
Questions can have a maximum of 102 characters, including punctuation and
spacing.

11. Fill in answer/s in the Answer field.  Enter the number of points. Multiple answers
and point values can be added for partial grading (whole numbers only).

12. (Optional) Set grading options. Participant's answers will be marked right or wrong
based on these options.
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13. Click OK when finished.
14. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
15. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Text Edit (only applicable to Q6RF)

1. Click the  New Question button. A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Text Edit as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

7. Click the button. This brings up the Question Properties window.

8.  (Optional) Send questions to Q6RF. Check the Send Question Text to Remotes box.
Questions can have a maximum of 102 characters, including punctuation and
spacing.

9. Enter the correct answer in the Correct Answer Text field.
10. Enter the text to be edited by participant in the Text Displayed on Device field.
11. Click OK when finished.
12. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank
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answer slide, click on the  Add Slide button.
13. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.

Equation (only applicable to Q6RF)
Create questions that allow participants to respond with numeric answers, including
special characters.

1. Click the  New Question button.  A blank slide appears on the right and the
thumbnail preview of the slide appears in the Slides tab on the left.

2. Click the Type drop-down list and select Equation as the slide type.
3. (Optional) Click on the Templates tab. Select a template; click and drag the

template onto the slide. See Styles and Templates for more details.
4. Enter text onto the slide.
5. (Optional) Add multimedia such as images, movies, and sound. Click on the Media

tab, type in a keyword/s, and click search. Drag and drop multimedia items onto
slide.

6. (Optional) Add custom style to slide. Click the Styles tab, browse and select a style.
Drag and drop style onto slide. See Styles and Templates for more details.

7. (Optional) Set the time limit.

8. Click the  button. This brings up the Question Properties window.

9.  (Optional) Send questions to Q6RF. Check the Send Question Text to Remotes box.
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Questions can have a maximum of 102 characters, including punctuation and
spacing.

10. (Optional) Fill in answer/s in the Answer field.  Enter the number of points. Multiple
answers and point values can be added for partial grading (whole numbers only).
11. (Optional) Add an equation to be edited by participant in the Text Display on Device

field.
12. (Optional) Set grading options. Participant's answers will be marked right or wrong

based on these options.
13. Click OK when finished.
14. (Optional) Create an answer slide. Click the Slides tab, press the black arrow on the

 Add Slide button and select Copy Current Slide. If you wish to create a blank

answer slide, click on the  Add Slide button.
15. When the slide is complete, either go to File menu and select Exit to save and close

Live Editor; or click the  New Question button to create a new slide set.
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6.2 Equation Tool

1. Click the  Equation button. Click and drag on the slide to select the area in
which the equation will be displayed.

2. The Set Equation window opens. Enter an equation.
3. Click Close (red X) when finished.
4. The equation appears on the slide as an object.
5. You can resize the equation by stretching the handles (click and drag).
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6.3 Styles and Templates

Live Editor makes creating, editing, and applying styles and templates easy.

Applying Styles
1. Create a slide with text.
2. Click each text box and set the text box type (Heading, Body 1, Body 2, Answer

Choices).
3. Click the Styles tab. Select a Category from the drop-down menu.
4. There are two ways to apply a style.

· Click and drag the style to the slide (on the right) to apply.
· Right-click the style and select Apply to Slide, Apply to Question, or Apply to

Activity.
5. You are able to change the font style, size, and color after applying the style.

Creating Styles
1. Click the Styles tab.
2. Click Edit Styles. This will bring up the Styles Management window.
3. Click New. The Input window appears.
4. Enter the name of your style, and click OK.

 Create a unique name for each style to make it easier and more accurate for
importing, exporting, and applying styles.

5. Click each tab to customize text, background, shapes, and categories of your newly
created style.

6. Create as many styles as you like. Click Done when finished.
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Text tab:
· Select Font Family, color, accent color (highlight), and style (Bold, Italic, and/or

Underline)

Background tab:
· Apply a Background Image- check the Back Image box and browse for the image.

Click Open, and thumbnail preview appears in the Sample window.
· Apply a Background Color- check the Back Color box and double-click inside the

Color box (located to the right of the Back Color box).
· Apply a Filter Color- applies a tint to your background image. Double-click in the

Color box and use the up and down arrows to apply the Filter Opacity. Notice the
thumbnail preview changes as you change Filter Opacity.

· Content Filter Color- changes the color behind your content. Double-click in the
Color box and use the up and down arrows to apply the Content Filter Opacity. Notice
the thumbnail preview changes as you change Content Filter Opacity.

The Content Filter Opacity will overwrite your Filter Color unless you scale the size
of content (see below for Content Scaling).

· Content Scaling- allows you to shrink and justify your content area. To decrease
overall size use the up and down arrows to increase or reduce percentage. To justify
scaling, select an icon that best fits your content needs.

Shape tab:
· Shape thickness-determines the size of stroke applied to drawn shapes. To select

thickness, check the Shape Thickness box, and type in the thickness of the line.
· Fill Color- applies selected color to all shapes drawn on an activity. To select color,

check the Fill Color box (if Fill Color box is unselected, the default color will be
applied to any drawn shapes), and double-click the Color box.

· Border Color-applies selected color to outline/stroke of any drawn shape. To select
color, check the Border Color box (if fill Border Color box is unselected, the default
color will be applied to any drawn shapes).

Categories tab:
· Categories-organizes styles in categories. Scroll through the list and check all

categories that apply( All, Abstracts, Biology, Cultures, Education, History, etc.). This will
add your style to the appropriate category in the main Style tab.

· Edit Categories- create, rename, and delete categories.

Edit Styles
1. Click the Styles tab.
2. Double-click the style you want to edit. The Style Management window appears.
3. Edit the style settings. See Creating Styles above for options.
4. Click Done when finished editing.
5. Reapply the style to view the updated style.
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Delete Styles
1. Click the Styles tab.
2. Double-click the style that you want to delete. The Style Management window

appears.
3. The style name appears in the Name field.
4. Click Delete. A prompt appears asking if you want to delete.
5. Click OK.
6. Click Done to exit the Style Management Window.

Import Styles
1. Click the Styles tab.
2. Click Edit Styles. The Style Management window appears.
3. Click Import. The Open window appears.
4. Select the .QSP (styles) file you want to import.
5. Click Open. The styles will import into Live Editor.

If there is a duplicate style already in Live Editor, it will ask you to Overwrite or Ignore.

Export Styles
Exporting styles exports all styles as a .QSP file.

1. Click the Styles tab.
2. Click Edit Styles. The Style Management window appears.
3. Click Export. The Save As window appears.
4. Select the location where you want to save the styles.
5. Enter the name with which you want the styles to be saved.
6. Click Save. The styles are saved in the selected location.
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Applying Templates
1. Click the Templates tab.
2. There are two ways to apply a template.

· Click and drag the template onto the slide.
· Right-click the template and select Load Template.

Templates must be applied before creating the slide.

Creating Templates
1. Create a slide with text and/or images and multimedia.
2. Go to the File menu and select Save As Template.
3. Enter a name for the template.
4. Select the slide type in the Question Types tab to set template question type filter.

Use Question Type Filter to sort and display the templates for a specified question
type.  Use the Type menu to select the question type, (Multiple Choice, True/False,
etc) and then check the Filter for selected question type box.

5. Select the Categories tab.
6. Select a category and click Done.

Creating Categories for Templates
1. Click the Templates tab.

2. Click  Browse. The Categories Editor window appears.
3. Enter a category name.
4. Click OK when finished.
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6.4 Multimedia

Adding Images
There are two ways to add an image to a slide.

Inserting an Image

1. Click the  Add Image button in the toolbar. The Open window appears.
2. Select the image and click Open.
3. The image appears on the slide.
4. Grab and drag the handles of the image to resize to desired size.

Using Media Search
1. Click the Media tab.
2. Enter the keyword(s) in the Keywords field to search for an image.
3. Images matching the keyword(s) you entered appears in the Media tab.
4. Select an image by dragging and dropping it onto the slide (on the right).

Adding Movies
There are two ways to add a movie file.

Inserting a Movie

1. Click the  Add Media button in the toolbar. The Open window appears.
2. Select the movie and click Open.
3. The movie appears on the slide.
4. Double-click the movie to play or right-click to set the media properties.

Using Media Search
1. Click the Media tab.
2. Enter the keyword flash in the Keywords field to search for a movie file (movie files

are Flash-based).
3. All available Flash files appear in the Media tab.
4. Select the desired Flash file and click, drag, and drop it onto the slide (on the right).

Adding Sound

1. Click the  Add Media button in the toolbar. The Open window appears.
2. Select the sound file and click Open.
3. The sound file appears on the slide.
4. Double-click the sound file to play or set the media properties.
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Media Control
Media Controls are most commonly turned on if an instructor device will not be used
during the presentation.

1. To turn on Media Controls. Go to the Window menu and select Media List. The
Media Control window appears. The Media Control appears during presentation.

· Play-blue triangle
· Pause-double green bars
· Stop-red circle

Setting Transparency for Flash Movies
1. Insert a flash movie onto the slide.
2. Right-click the flash movie and select Properties.
3. Check the Play Transparently box.
4. Click OK.
5. Click the movie. The flash movie is transparent only when playing.

Media Properties
1. To set Media Properties, right-click the movie or sound file.
2. Select Properties. The Media Properties window will appear.  Select the options for

presentation.

· Visible in presentation-displays the movie and the name of the sound file on the
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slide.
· Play when clicked-plays the movie or sound file when clicked with mouse.
· Show Controller-displays a box of the movie and/or sound file names with play and

stop buttons.
· Repeat-repeats movie or sound file continuously when the slide is displayed.
· Close when finished-stops movie or sound file when finished.
· Play full screen-plays movie in full size; displays sound in colors (best used with only

the sound file on the slide).
· Play Transparently-applies to Flash movies; background becomes transparent

when movie is played.
· Play automatically-plays the movie or sound file upon slide display.
· Delay ---- seconds before playing-enter number of seconds to pause before the

movie or sound file plays.
4. Click OK to apply.
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7 Participants

Creating a Participant List
1. Click the Participants tab.

2. Click the  Participant Wizard button.  The Participant wizard opens.
3. Select Create New Participant List.
4. Enter a name for the participant list and click Next.
5.  Templates are commonly used fields that allow you to quickly add fields to a

participant list. Select a template or click Next to skip this step.

Remote ID is a default column within the templates.  You do not need to
create a field for the Remote IDs, otherwise you will have two Remote ID
columns.

6. In the Participant Field Selection window, add and/or remove the different fields
you would like to use.  If you do not see a field you would like in the participant list,
you can create a customized field. Click Next when finished.

7.  A blank participant list will appear.
8. Fill in the fields and click Finish.  The participant list will save into the Participants

Tree.

Importing a .CSV (Comma Separated Values) File
You can import .CSV file and convert it into Qwizdom participant lists (.QPL).

If you have a participant list in Microsoft Excel® you would like to import, save it as
.CSV files.

1. Click the Participants tab.

2. Click the  Participant Wizard button.  The Participant wizard opens.
3. Select Import / CSV.
4. The Open window will appear. Search for the .CSV file you want to import.
6. Select the .CSV file and click Open.
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7. Match the fields on the left to the fields on the right.  If you don't know what the
field is, select None.

8. If the information on the left are headers, check the First Record is Header box,
otherwise leave it unchecked.  For example, if the imported information on the left
shows column headers such as Last Name, First Name, Remote ID, etc., those are
headers so you would check the First Record is Header box.  If the information on
the left shows the actual name, Remote ID, etc., uncheck First Record is Header
because those are not headers.

9. Click Next when all the fields have been matched.
10.    The participant list will appear. Click Finish to save and close. The participant list

will be saved in the Participants Tree.

Creating an Anonymous List
Before using an anonymous list, be sure you have the correct estimated number of
remotes set within the Configurations Settings window.  For example, if you create an
anonymous list with a hundred participants but only have eighty as the estimated number
of remotes, then not all remotes will register.

1. Select an activity, answer key, etc. to present.

2. Click the  Present button.  The Presentation Setup window opens.
3. Click the Participant List drop-down list and select Anonymous.
4. Enter in the number of participants.  The anonymous list has been created.

In Configuration Settings, check to make sure the estimated maximum number of
remotes reflects the number of the participants (or higher).  e.g If you have 32
participants but 24 as the estimated maximum number of remotes, then only 24
remotes will be allowed.

5. Click OK to begin presentation.

Editing an Existing Participant List
1. Click the Participants tab.

2. Click the  Participant Wizard button.  The Participant wizard opens.
3. Select Browse and Modify Existing List.
4. Click Next.  The Open window opens.
5. Search for the participant list you want to edit.
6. Select it and click Open.  The name of the participant list appears in the Name field.
7. Click Next.  You will be taken to Participant Field Selection.  You may add new fields

or remove existing fields.  If you do not want to change anything, skip to the next
step.

8. Click Next.  The participant list will appear.

You can renumber the remotes according to the order of any column you
choose by going to Options menu (located in the top left corner of the
Participant Wizard window) and selecting Auto number Remotes.
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9. Make the necessary changes and click Finish when done.  The participant list will
save into the Participants Tree.

Importing Class Lists from Qwizdom Interact
1. Click the Participants tab.
2. Go to the File menu and select Import.
3. Select Import Classes from Interact.  The Interact Import window opens.
4. Select the class(es) you want to import and click Import.
5. The classes will import into the Participants Tree.
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7.1 Groups

Automatically organize students into groups based on Ability, Odd and Even Numbers,
Activity Score, or Performance.

Creating Groups
1. Click the Participants tab.
2. Select a participant list for which you want to create groups.

3. Click the  Groups button.  The Group Management window will open.
4. In the Automatic Grouping Options tab, select the Grouping Action.

· Balance-groups students by ability. Each group will have an equal number of
high, medium, and low performing students.

· Group Similar-groups students by ability; high together, medium together, low
together.

· Random-groups students randomly; groups may be odd/even.
· Group Size-specifies the number of students in each group.
· Activity Score-groups students based on overall grade on a particular activity.

5. Click Generate. The created groups appears in the window.
6. (Optional) To manually alter groups, click a student and then drag and drop the

selected student into the desired group.
7. Click Done when finished. The group numbers of each participant appears in the

Participants window.
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7.2 Seating Chart

The seating chart is used to track student seating.

1. Select the participant list for which you want to set up the seating chart.

2. Click the  Seating Chart button. The Seating Chart window appears.
3. A list of the participant names will display in the column on the right.
4. Click and drag the names of participants to place them onto the seating chart.
5. Click OK when finished.
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8 Presentations

Activities can be presented with or without Qwizdom remotes.

Presenting an Activity (with Remotes)
1.      Click on the Content tab.
2. Select an activity to present.

3. Click the  Present button. The Presentation Setup window appears. (See
Presentation Setup for details. )

4. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.

5. Click the Saved Results drop-down arrow and select how you would like to save the
results.

6. Select the options you would like available during presentation in the General,
Login, and Chart tabs in the lower part of the Presentation Setup window.

7. Click OK to begin the presentation.
8. Have the participants turn on their remotes.
9. Either the answer choices or a blank screen appears on the remote, depending on

the question type.
10. Here are a few things you may execute during presentation:

· Display the public response graph or private graph (See Response Graph
for details.)

· Randomly call upon a participant (See Presentation Features for details.
· Pose a spontaneous question (See Posing Spontaneous Questions for

details. )
11. Go through the presentation until all the question slides are answered.

 See Using Remotes in Presentation for description and troubleshooting of all the
remote LCD screen messages.

12. When you are unable to advance to the next slide, this means the presentation is

complete. Click the Utilities button and select Exit.

Presenting an Activity (without Remotes)
1. Go to the Remotes menu and check the Do not use Qwizdom Remotes box.
2. Click on the Content tab.
3.  Select an activity to present.

4. Click the  Present button. The Presentation Setup window appears. (See
Presentation Setup for details. )

5. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.

6. Click the Saved Results drop-down arrow and select None (Do not save).
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7. Select the options you would like available during presentation in the General,
Login, and Chart tabs in the lower part of the Presentation Setup window. See
Presentation Setup for complete descriptions of presentation features.

8. Click OK to begin the presentation.
9. Go through the presentation until all the question slides are answered.
10. When you are unable to advance to the next slide, this means the presentation is

complete. Click the Utilities button and select Exit.

Presenting Multiple Answer Keys
Before presenting an activity using Qwizdom remotes, please see Presentation Setup to
learn about the presentation features.

1. In the Content Manager tree, select the folder that contains the answer keys.

2. Click the  Present drop-down arrow and select Present Multiple Answer Keys.
3. The Presentation Setup window appears.
4. Click the Participant List drop-down field and select what type of participant list you

would like to use.
5. Click the Saved Results drop-down field and select how you would like to save the

results.
6. Select the options you would like available during presentation in the General,

Login, and Chart tabs in the lower part of the Presentation Setup window.
7. Click OK to begin the presentation.
8. The Privacy Screen appears.
9. Activity ID appears on the remote LCD screen.

An activity ID is the answer key test number. Double-click the answer key to
launch Answer Key to view the test number.  Write down the test number for
each answer key for participants to enter.

10. Enter the test number (activity ID) of the answer key into the remote and press the
Send key.

11. The answer key will load into the remote.

 See Using Remotes in Presentation for description and troubleshooting of all the
remote LCD screen messages.

12. Click the red X (within the window) to show a grid of the participants' progress
(optional).

13. When all answer keys have been completed, click  End Session.
14. You will be taken back to the Answer Key Maker window.
15. The saved results will save in the location you selected.
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8.1 Presentation Setup

There are many options you can apply to your presentation. Not all options will be
applicable.

General tab:
Send Right/Wrong Feedback to Remotes after answering-remotes will receive a check
mark if answer is correct and an X if answer is incorrect. Remotes will receive both a
check mark and X to indicate that the response has been received, if feedback is turned
off.
Allow participants to change answer-checking this option allows participants to
change their answer for the current question slide.
Override Points Value with Global Point value of ---- points-enter the new amount of
points that will be temporarily applied to the slide for that presentation.
Timer-you can select no timer, use the time set within the slides, or global timer by
entering the number of seconds for all slides in the presentation.
Use Virtual Remotes--feature coming soon
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Login tab:
Require Login by ID-checking this option will have remotes prompt participants to
enter their Participant ID.
Show Login Screen-displays the login screen so the instructor can view the participants
that are logging in.
Add & Allow Unregistered participants-participants will be added to the participant
list by logging in with their Participant ID. This option must be checked when using an
Anonymous list. For the Anonymous list, participants will only log in with the Session ID.
Deny Login After ---- minutes-logins after the set amount of time will not be accepted.

Chart tab:
Automatically Show Correct Answer on Chart-displays a fraction and percentage of
correct answers.
For example: Correct Answer(s)10/12 83%.
Background Filename-allows you to select an image to display as the response chart
background.
Select Graph Layout-selects how the response chart will be displayed during
presentation.
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Advanced Settings
To change advanced settings

1. Click  Present. The Presentation Setup window appears.
2. Go to File and select  Advanced Settings. The Advanced Settings window opens.

Advanced Settings
· Allow Instructor to go back to a previous slide-allows the Q5RF Instructor Remote

and Q7RF Tablet to move back to a previous slide.
· Reset Com-Port When Starting Presentation-this option is checked by default to

ensure the host activates when presentation begins.
· Ask for confirmation of User ID when not on list-the remote will prompt the

participant for the user ID again, if the participant is not in the participant list that is
loaded.

· Use Audio Feedback when using Tablet Keys-when using the Tablet, the computer
will emit a beeping sound as a notification that the Pen and Tablet are
communicating.

Advanced Hardware Settings
· Don't require "Send" on single key answers-the remote will automatically send the

answer once it has been entered.
· Disable "Change UserID" menu during Login-hides the User ID option from the

menu.
· Disable "Change SessionID" menu during Login-hides the Session ID option from

the menu.
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· Disable "Change UserID" menu during active Session-hides the User ID option from
the menu during presentation.

· Disable "Change SessionID" menu during active Session-hides the Session ID option
from the menu during presentation.

· Do not show what key was pressed on Q2's-does not show the key that is pressed
on the display.

· Turn off remotes on presentation end-automatically turns off the Q2RF and Q4RF
remotes when a presentation ends.

· Show score on Remote in Self-Paced Mode-checking this option displays the
participant's score on the remote when the participant has completed the answer
key.

8.1.1 Presentation Settings

Presentation settings can be saved and loaded (onto the same computer or another
computer) into the Presentation Setup window.

Saving Presentation Settings
1. In the Presentation Setup window, select the options you would like during

presentation.
2. Go to the File menu and select Save Settings. The Save As window appears.
3. Enter the name for the selected settings.
4. Click Save. The settings will save as a .CFG file in the location you selected.

Loading Presentation Settings
1. In the Presentation Setup window, go to the File menu.
2. Select Load Presentation Settings. The Open window appears.
3. Select the saved settings file (.CFG) and click Open.
4. The current settings in the Presentation Setup window will change to the settings

you selected to load.

8.1.2 Saving Results

All results are saved as a .QRX file but can be converted into a .CSV (Comma Separated
Values) file.

Manual Save

1. Click the  Present button.  The Presentation Setup window opens.
2. Select Browse for Save Location.
3. Click the  Browse button. The Save As window appears.
4. Select a location in which to save the results.
5. Enter the name with which you want the results to be saved.
6. Click Save. The file name and location appears in the Save Results field.
7. The results will save in the selected location when the presentation is complete.
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Auto-save

1. Click the  Present button.  The Presentation Setup window opens.
2. Select Auto Save as 'Filename + List + Date.'
3. The Browse for Folder window appears.
4. Select the location and click OK. The save results will always save in this location

unless you select another save location.
5. The file name will contain the location, name of the participant list, date, and time

in the Save Results field.
6. The results will save in the selected location when the presentation is complete.

Auto-Save to Results Manager

1. Click the  Present button.  The Presentation Setup window opens.
2. Select Auto Save to Results Manager.
3. The results will save in the Results tab when the presentation is complete.

8.1.3 Remote Login

 If you are presenting with remotes for the first time please see Remote Setup.

Logging in with IDs allows participants to use any remote.  If you use Participant IDs from a
participant list, the ID will link the remote to the participant's information in the list.

To have participants log in, they must have a Participant ID.  Participant IDs are setup when
creating participant lists.  (Go to Participant Lists for more information).  Each participant
should have a unique ID assigned to his or her name.

· Participant IDs can only be numeric.
· The maximum number of digits allowed for IDs using the Q2RF remotes is 8.
· The maximum number of digits allowed for IDs using the Q4RF remotes is 9.
· The maximum number of digits allowed for IDs using the Q5RF remotes is 8.
· The maximum number of digits allowed for IDs using the Q6RF remotes is 15.
· IDs cannot be used for more than one participant (IDs cannot be duplicated).

1. Select an activity or create one to present.

2. Click the  Present button.  The Presentation Setup window opens.
3. Select a participant list from the Participant List drop-down menu.
4. Click the Login tab.
5. Check the Require Login by ID option.
6. Checking the Show Login Screen is optional.
7. Select all other preferred options and click OK to present.  The presentation will

begin.
8. The remotes will display User ID.
9. Participants will enter their ID and press the Send (double arrows) key.
10. Once everyone has logged in, begin the presentation.
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You can start the presentation as participants log in. Participants who are late can log in
later if you have not set a timer to deny log-in.

Login Timer
You can deny login after a certain amount of time by setting the time under the Login tab.

1. Check the Deny Login After ---- Minutes option.
2. Enter the number of minutes that participants have to log in.

For example, you have selected to deny log in after 5 minutes. After 5 minutes have
passed, participants who try to log in will be denied.
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8.2 Presentation Toolbar

8.2.1 Presentation Features

Qwizdom Toolbar
There are many ways to customize your Qwizdom presentations. Right-click on the
Qwizdom Toolbar to view options menu.

Buzz-In Box/Participant Counter
The Buzz-In Box displays the percentage of participants who have answered.

During a presentation:
1. Right-click the Qwizdom Toolbar and go View/Buzz-in Box.
2. Click the Buzz-In Box  to change the indicator view from percentage to fraction.
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Answer Grid
 The Answer Grid indicates participant response by corresponding remote ID numbers.

To Show/Hide the Answer Grid.
1. Right-click the Qwizdom Toolbar and go View/Answer Grid.
2. Right-click Answer Grid to change display settings, including size, number of

columns, placement, etc.

Qwizdom Tools
Includes three presentation tools including , the Response Graph, Pick, Re-pose, and
Game/Show. Use when presenting activities without the Q5RF Instructors Remote or the
Q7RF Presenter Tablet.

Response Graph

1. Click the  Response Graph button.
2. The Response Graph appears.
3. Click the available chart(s) to view the results.
4. Double-click the title bar of the window to display the graph in full screen.

Picking Participants

1. Click the  Pick button to randomly call upon a participant.
2.  The participant's name appears on screen.

3. Click the  Pick button again to remove the name.

Re-posing a Question
Re-posing is used to ask a question again and/or  when you accidentally skip a slide that
needs to be answered. Reposing the question overwrites the previous responses if any are
recorded.

1. Click the   Re-pose button to ask the question on the slide again.

Game/Show
Shows game animation.

1. Click the  Game button to view game windows, including scores, animations,
etc.

Automatically Show Correct Answer on Chart
Displays a fraction and percentage of correct answers. For example: Correct
Answer(s)10/12 83%.
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1. Right-click the Qwizdom Toolbar and select Setting.
2. Under the Display tab,  select Automatically Show Correct Answer on Chart

Timer
You can set the timer two ways; use the time from each slide or apply a new time during
the presentation.
To set a new time to the presentation:

1. Right-click the Qwizdom Toolbar and select Setting.
2. Under the Display tab,  select Use Global Timer Value of--- from the Timer drop-down

menu.
3. Enter the number of seconds.
4. Click OK to close presentation options and apply changes.

To quickly view or hide Timer, right-click the Qwizdom Toolbar and go
View/Timer.

Points
You can set the point value two ways; use the point value from each slide or apply a new
point value to all the questions in the presentation.  When you create a slide, you enter the
number of points the correct response will be awarded.  Go to Creating a Slide for more
information.
To apply a new point value to all the questions in the presentation:

1. Click the  Present button. This brings up the Presentation Setup window.
2. Check the Override Point Value with Global Point value of --- points option in the

General tab.
3. Enter the number of points.
4. Click OK to present the presentation with the newly set point value.

Right/Wrong Feedback
This allows participants to see if their response is right or wrong.

1. Click the  Present button. This brings up the Presentation Setup window.
2. Check the "Send Right/Wrong Feedback to Remotes after answering" box in the

General tab.
Feedback appears on the LCD screen of the participant's remote during presentation.  A
check mark will indicate a correct response, an X will indicate an incorrect response. If the
feedback is disabled, a check mark and X appears on the LCD screen indicating that a
response was received.
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8.3 Response Graph

During presentation, you can display a response graph to see the results of the question.
There are two response graphs you can display: the public response graph and the private
graph.

Public Response Graph using the Q7RF Tablet
1. Press the  Public Graph icon on the Q7RF Tablet.
2. The response graph appears on the computer screen.

3. Press the  Public Graph icon on the Q7RF Tablet again to close the response
graph.

If you have a graph displayed, either on the Q7RF Tablet or computer, you must
first remove that graph before displaying the private response graph and/or
move onto the next question.

Private Response Graph using the Q7RF Tablet
1. Press the  Private Graph icon on the Q7RF Tablet.
2. The response graph will display on the Q7RF Tablet's LCD.

3. Press the  Private Graph icon on the Q7RF Tablet again to close the response
graph.

Public Response Graph using the Q5RF Instructor Remote
1. Press the / key on the Q5RF Instructor Remote.
2. The response graph appears on screen for the participants to view.
3. Press the right/left arrows to view a different graph of the results.
4. Press the / key again to remove the response graph.

If you have a graph displayed, either on the Q5RF Instructor Remote or computer,
you must first remove that graph before displaying the private response graph
and/or move onto the next question.

Private Response Graph using the Q5RF Instructor Remote
1. Press the 0 key on the Q5RF Instructor Remote.
2. A bar chart showing the number of responses will display on the Q5RF Instructor

Remote's LCD screen.
3. Press the 0 key again to remove the graph.
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Bar Chart
Displays results as a bar chart. Click or press the Bar Chart to change the bars from
horizontal to vertical.

Press the circle key to show bars horizontally or vertically.

Pie Chart Displaying Correct Answer with Number of Responses
Displays results as a pie chart with numbers and the correct response. Click on actual pie
chart to show results as whole or in sections.
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Pie Chart Displaying Correct Answer with Percentages
Displays results as a pie chart with percentages and the correct response. Click on actual
pie chart to show results as whole or in sections.

Pie Chart Displaying Number of Responses
Displays results as a pie chart with numbers. Click on actual pie chart to show results as
whole or in sections.
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Pie Chart Displaying Percentage of Responses
Displays results as a pie chart with percentages. Click on actual pie chart to show results as
whole or in sections.

List View Chart
Displays results in the order it was received by Remote ID, Participant ID, Participant Name,
their response, how long it took for the response to be received, and if their response was
correct.
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Scores Chart
Displays results by Remote ID, Participant ID, Participant Name, points, and their current
percentage (which is accumulative) for the presentation.

Private Response Graph
1. Press the 0 key on the Q5RF Instructor Remote.
2. A bar chart showing the number of responses will display on the Q5RF Instructor

Remote's LCD screen.
3. Press the 0 key again to remove the graph.
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8.4 Posing Spontaneous Questions

Spontaneous questions can be posed during presentation with the Q5RF Instructor
Remote or Q7RF Tablet.

Pose Question (with Q7RF Instructor Tablet)
An activity must be in presentation mode before following the instructions below.

1. Click the  New Question drop-down arrow. A list of question types appear on the
remote's LCD screen.

2. Use the up and down arrows to scroll through the list of question types.
3. Press the Enter key to select the question type you want to pose.
4. Select or enter the correct answer.
5. Click the Send button on the Q7 Presenter Tablet.
6. Participants will either see the answer choices or a blank on their remotes. At this

time, they would select or enter their response and press the Send key to confirm.

7. Click the Stop icon when time is up or after everyone has responded.

8. (Optional) Click the  Public Graph icon to display the response graph. Click the
Public Graph icon again to close the response graph.

Quick Pose Question (with Q7RF Instructor Tablet)
1.  Using the pen, touch on any answer on the bottom of the tablet.

· If you are posing a numeric question, touch the answer and then press the
Enter key to send it.

· If you are posing a survey (no answer) question, touch one of the Any icons
for the specific question type.

2. Click the Send button on the Q7 Presenter Tablet.
3. Participants will either see the answer choices or a blank on their remotes. At this

time, they would select or enter their response and press the Send key to confirm.

4. Click the  Stop icon when time is up or after everyone has responded.

5. (Optional) Click the  Public Graph icon to display the response graph.

Pose Spontaneous Question (with Q5RF Instructor Remote)
An activity must be in presentation mode before following the instructions below.

1. Press the New Q key on the Q5RF Instructor Remote. A list of question types
appear.

2. Use the thumb pad to scroll through the different question types.
3. Press the Circle (thumb pad) key to select the question type you want to pose.

· The answer choices appear for Multiple Choice, Yes/No, True/False, and
Multiple Mark. Select the correct answer and press the Send key.

· For Numeric, Sequence, and Short Answer, you will need to enter the answer.
Enter the answer and press the Send key.

· For survey questions (no correct answer), press the Send key without
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selecting an answer.
4. Participants will either see the answer choices or a blank on their remotes. At this

time, they would select or enter their response and press the Send key to confirm.
5. After all participants have responded, press the Public Graph [ / ] key to display the

response graph. Press the Public Graph [ / ] again to close the response graph.
Spontaneous data will be recorded if you chose to save the results.

Pose Spontaneous Question (without Instructor Remote)
An activity must be in presentation mode before following the instructions below.

Check the Show Function Toolbar box in the Presentation Setup window to display
the Response Graph, Pick, and Re-pose buttons during presentation.

1. Click the  New Question drop-down arrow.
2. Select the question type you want to pose.
3. Select or enter the correct answer.

4. Click the   Pose icon.
5. Participants will either see the answer choices or a blank on their remotes. At this

time, they would select or enter their response and press the Send key to confirm.

6. Click the  Stop icon when time is up or after everyone has responded.

7. (Optional) Click the  Public Graph icon to display the response graph.



Presentations 98

Qwizdom Connect 2010

8.5 Games

Actionpoint and Connect both offer the Qwizdom games.

There are different ways to display the game animations during presentation:

Actionpoint

· Using computer mouse-Clicking the Game button in the function toolbar will
display the game animations.

· Tablet-press the  Show icon.
· Q5RF Instructor-press the 7 key.

Connect
· Using computer mouse--click the right arrow in the Presentation toolbar to advance

to the next slide.

· Tablet-press the Show icon or advance to the next slide.
· Q5RF Instructor-press the right arrow key.

Baseball
Two teams are needed to play Baseball, which the program will automatically group by
remote numbers: odd number remotes vs. even number remotes. The outcome of the
game depends on the number of correct responses of each team for each question.

1. Click the  Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Click the Presentation drop-down arrow and select Baseball.
6. Select the options you would like available during presentation in the General,

Login, Display and Chart tabs in the lower part of the Presentation Setup window.
7. Click OK to start the presentation.
8. The Baseball setup window will display the odd and even remote numbers in their

respective teams.
9. A batter appears for the team that is up; a question slide will follow.
10. Participants from both teams will send in their responses.
11. The outcome of each play is determined by the number of responses from each

team. The game will go in favor of the team with the most correct responses in the
least amount of time.

12. The winning team will be displayed when all questions have been answered or
when the game has ended.
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Fast Track
Fast Track is a race car game in which points are rewarded based on the response time of
each remote.

1. Click the  Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Click the Presentation drop-down arrow and select Fast Track.
6. Select the options you would like available during presentation in the General,

Login, Display and Chart tabs in the lower part of the Presentation Setup window.
7. Click OK to start the presentation.
8. A question slide appears.
9. Participants will send in their responses.
10. Points are awarded by correct responses sent in the least amount of time.
11. The winner will be displayed when all questions have been answered or when the

game has ended.

Mission to Mars
Mars Mission is a space ship game in which points are rewarded based on the response
time of each remote.

1. Click the  Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Click the Presentation drop-down arrow and select Mars Mission.
6. Select the options you would like available during presentation in the General,

Login, Display and Chart tabs in the lower part of the Presentation Setup window.
7. Click OK to start the presentation.
8. A question slide appears.
9. Participants will send in their responses.
10. Points are awarded by correct responses sent in the least amount of time.
11. The winner will be displayed when all questions have been answered or when the

game has ended.

Quandary
Quandary is a Jeopardy-like game where users select various dollar amount questions from
a game board. 25 slides (questions) are recommended in order to fill the game board.

1. Click the  Present button.
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2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Click the Presentation drop-down arrow and select Quandary.
6. Select the options you would like available during presentation in the General,

Login, Display and Chart tabs in the lower part of the Presentation Setup window.
7. Click Settings. The Quandary Configuration window appears. Quandary

Configuration is where the game options are set up for presentation.

8. Enter the name of each topic. Each topic represents a category of questions.
9. Enter the slide numbers related to the particular topic. Each slide represents a

different dollar amount in each category (starting from 100 to 500).
10. Select the scoring option for the game.
11. Check the Use Teams from Participant Lists When Available box to use pre-existing

groups (created in the Participants tab) or have the game create temporary groups
(which the program will assign) for the current presentation.

12. Click OK. You will be taken back to the Presentation Setup window.
13. Click OK to start the presentation.
14. The Team Members screen appears displaying remote numbers in each group.
15. Press or click 1 Categories to start the game.
16. The game board will display with the categories and dollar amounts.
17. Select a dollar amount from a category. A question slide appears.
18. Participants will use the remotes to send in their responses.
19. Team points are based on the number of correct responses from each team
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member. Individual scores are based on how fast the user was able to send in the
correct answer because the first remote to send in the correct answer receives all
the points for that question.

20. The winning team will be displayed when all questions have been answered or
when the game has ended. The individual winner can be determined in the Player
Scores screen.
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9 Results

You can generate reports* using existing saved results.
*Registered  version of Microsoft Excel® is required to generate reports.

1. Click the Results tab.
2. Select the Results File (.QRX) from which you would like to generate reports.

3. Click the  Report Wizard button.  The Reporting Wizard window opens.

Reports and Features
· Answer Report-displays the class average score bar chart, participant question

responses, correct answers, and scores.
· Answer Distribution Report-displays total percentage of responses for each question

with correct answer and bar chart.
· Score Report-displays participant information with various point totals and scores.
· Question Summary Report-displays a thumbnail preview of each question within an

activity with a bar chart indicating question responses next to each question.
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· Standards by Question Report-displays the standards that are linked to the
questions (activity).

· Standards Mastery Report-displays percentage of class that met each standard in
the activity.

· Participant Detail Report-displays participant information.
· Participant Group Overview Report-displays participant group information.
· Attendance Report-displays participant information with their remote login time.

· Participant Comparison Report-displays a comparison of the participant's
question responses, correct answer, and score to the whole class' results.

· Student Question Summary Report-displays a thumbnail preview of each
question within an activity with answer details next to each question, including
correct answer, participant response, class percentage, and mode.

· Student Standards Report-displays how the individual participant met each
standard in the activity.

Flash Reports
· Question Summary (with Answer)-based report displays each question slide with

response charts, marking the correct answer in green.
· Question Summary (without Answer)-based report displays each question slide

with response charts.
· Answer Report -displays each question slide with the user's response and the

correct answer.

Export:
· Convert to .CSV-convert .QRX file to .CSV.

Options:
· Override the Point value of all slides to be --- points-overrides point value that was

awarded during presentation.

4. Select the type of report you want to generate and click the Generate button.
5. This will launch the Report Viewer window. View, print, and export reports.
6. Close the Report Viewer window when finished. This will bring you back to the

Reporting Wizard. Select another report or click Done when finished.
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10 Answer Key

Grade existing class worksheets, paper-based tests, and textbook material in the Answer
Key Mode.

Creating an Answer Key
1. Click on the Content tab. Click the   New Answer Key button. Enter a name for

the activity and click OK.
2. The Answer Key appears in a folder titled Recently Added Answer Keys located in the

Content Tree on the left. Double-click on the Answer Key to launch the Answer Key
Maker.

3. Click the  Insert a Question button.
4. Click on the Type field and select a question type.
5. Click on the Answer field to set correct answer.  (Optional) Choose Advanced  for

partial grading options (if applicable) and/or to send question text to Q6RF student
remotes.

6. Set the number of points.

7. Click the  Insert a Question button and repeat steps 4-6.

If you delete a question or if the numbering is not in sequential order, go to
the Tools menu to select Renumber Questions to correct.

8. When the answer key is complete, click the  Save button.

Presenting an Answer Key

1. Click on the Content tab.
2. Double-click an Answer Key file in Content Tree the to launch the Answer Key Maker

window.

3. Click the  Present button.
4. The Presentation Setup window appears.
5. Click the Participant List drop-down arrow and select what type of participant list

you would like to use. Select Qwizdom Connect to choose a class/participants list
created in Qwizdom Connect.

6. Click the Save Results drop-down arrow and select Auto Save to Results Manager
(recommended). This automatically saves a .QRX file located under the Results tab
(see Saving Results for other options).

7. Select the options you would like available during presentation in the General,
Login, and Chart tabs in the lower part of the Presentation Setup window (see
Presentation Setup for details).
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8. Click OK to begin the presentation.
9. The Privacy Screen appears. (Optional - Click the red X within the window to show a

grid of all the participants and their progress.)
10. The answer key will load into the remote.
11. When all answer keys have been completed, click  End Session.

Instruct students to push the right directional arrow keys after answering the last
question to complete the answer key activity.  The remote LCD screen will display
"Complete... Y or N" Click on the T (Yes) button to confirm that they have
completed the activity. If the activity is not complete, the student's score will not
be recorded.

12. You will be taken back to the Answer Key Maker window.
13. The saved results will save in the location you selected.

Presenting Odd-Numbered Questions
1. Click on the Content tab.
2. Double-click an Answer Key file in Content Tree the to launch the Answer Key Maker

window.
3. Go to the Edit menu and select Select Odd. Only the odd-numbered questions will

be checked.

4. Click the  Present button.
5. Participants will only answer the odd-numbered questions during their answer

key.

Presenting Even-Numbered Questions
1. Click on the Content tab.
2. Double-click an Answer Key file in Content Tree the to launch the Answer Key Maker

window.
3. Go to the Edit menu and select Select Even. Only the even-numbered questions will

be checked.

4. Click the  Present button.
5. Participants will only answer the even-numbered questions during their answer

key.

Presenting Selected Question Numbers
1. Click on the Content tab.
2. Double-click an Answer Key file in Content Tree the to launch the Answer Key Maker

window.
3. Check the question numbers you want to present.

4. Click the  Present button.
5. Participants will only answer the selected question numbers during their answer
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key.

Presenting Multiple Answer Keys
1. Before presenting multiple Answer Keys you may need to export your Answer Keys

from the Content Tree to a designated folder. If you have already saved your
Answer Keys to folder outside of Connect skip to step 7.

2. Create a new folder outside of Connect (i.e. Desktop, My Documents, etc.). This is
where your Answer keys will be saved.

3. Export your Answer Keys. Click on the Content tab. Select the activity in the Content
Tree you wish to export.

4. Go to the File menu and select Export. The Save As window appears.
5. Browse to the newly created folder and click OK.
6. Go to the Programs menu and select Answer Key. This will launch the Answer Key

Maker window.

7. Click the  Open button. The Open window appears.
8. Browse to the folder where the Answer Keys are saved. Select an answer key and

click Open.
9. The answer key will open with the Test Number (Activity ID) in the title bar of the

window.
10. Write down the test number (activity ID).
11. Open another answer key and do the same.
12. Click the black arrow to the right of the Present button.
13. Select Present Multiple Answer Keys.
14. The Browse for Folder window appears.
15. Select the folder in which both Answer Keys are saved.
16. Click OK and the Presentation Setup window opens.
17. Click the Participant List drop-down arrow and select what type of participant list

you would like to use. Select Qwizdom Connect to choose a class/participants list
created in Qwizdom Connect.

18. Click the Save Results drop-down arrow and select Auto Save to Results Manager
(recommended). This automatically saves a .QRX file located under the Results tab
(see Saving Results for other options).

19. Select the options you would like available during presentation in the General,
Login, and Chart tabs in the lower part of the Presentation Setup window (see
Presentation Setup for details).

20. Click OK to begin the presentation.
21. The Privacy Screen appears.
22. Activity ID appears on the participant's remote LCD screen.

An activity ID is the answer key test number. Double-click on the answer key to
launch Answer Key to view the test number.  Write down the test number for each
answer key for participants to enter.
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23. Enter the test number (activity ID) of the answer key into the remote and press the
Send key.

24. The answer key will load into the remote. (Optional - Click the red X within the
window to show a grid of all the participants and their progress.)

25. When all answer keys have been completed, click  End Session.

Instruct students to push the right directional arrow keys after answering the last
question to complete the answer key activity.  The remote LCD screen will display
"Complete... Y or N" Click on the T (Yes) button to confirm that they have
completed the activity. If the activity is not complete, the student's score will not
be recorded.

26. You will be taken back to the Answer Key Maker window.
27. The saved results will save in the location you selected.

Generating a Report for an Answer Key
1. Click on the Results tab.

2. Select the newly create results/scored activity (.QRX file). Click the  Report Wizard
button.

If you saved the results to another location outside of Connect. Click the Reports
Wizard button and browse to the results file.

3. Select a report type (see Results for details).
4. Click Generate.
5. The report will display with options to view, print, and export reports.
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11 Qwizdom Actionpoint

Turn any PowerPoint® slide show into a Qwizdom interactive presentation using Qwizdom
Actionpoint. A clean bar fits snugly at the top of the program window, allowing the user to
instantly insert new slides, set up question types, timer, add points, play games, and more.

There are three ways to launch Qwizdom Actionpoint.
· Go to the Programs menu and select Actionpoint.
· Right-click the Qwizdom Tools icon, located in the lower right-hand corner of the

Windows Taskbar, next to the clock and select Actionpoint.

· Double-click a PowerPoint file on your computer to launch Microsoft PowerPoint®,
which will automatically launch and display Qwizdom Actionpoint.

Microsoft PowerPoint® will open displaying the Qwizdom Actionpoint toolbar.
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11.1 Actionpoint Overview

From left to right:
Present  button -presentation setup
Insert Slide-creates a new slide
Question-displays slide type
Type-number of choices (applicable depending on question type)
Answer-correct answer or None for survey
Advanced Options-send text questions to Q6RF remotes during a
presentation or set advanced grading/answer options
Points-number of points awarded for correct response
Timer-allows slide to be viewed in presentation for time that is set
Configuration Settings button-remote setup
Participants button-creates, modifies, imports participant lists
Reports button-uploads saved presentation results to generate reports
Settings button-additional options for Actionpoint
Standards-add standards to an activity
About button-displays software version number and user guide



Qwizdom Actionpoint 110

Qwizdom Connect 2010

11.2 Slides

 Multiple Choice

1. Click the  Insert Slide drop-down menu.
2. Select Multiple Choice and the number of answer choices.  The template appears on

the slide.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and

using templates and styles are optional.
4. Click the Answer drop-down menu and select the correct answer.

5. Click the  Advanced Options button to view advanced grading options and/or to
send question text to Q6RF remotes, while in presentation mode. Questions can
have a maximum of 102 characters, including punctuation and spacing.

6. (Optional) Click the Points drop-down menu and select the point value or type in
the desired point value and press the Enter key on the keyboard to apply the point
value to the slide.

7. (Optional) Click the Timer drop-down menu and select the time or type in the
desired time limit and press the Enter key on the keyboard to apply the time to the
slide.

 Multiple choice answers are limited to a maximum of 15 characters. If you would
like to display answer choices on Q6RF LCD screens longer than 15 characters,
uncheck the Send Answer Choices to Remotes option. Then enter in your question
and answer choices into the Send Question Text to Remotes field, keeping in
mind that there is a 102 character limit.

Yes/No &  True/False Slides

1. Click the  Insert Slide drop-down menu.
2. Select the type of slide you want to create.  The template appears on the slide.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and

using templates and styles are optional.
4. The Question field will indicate the slide format.
5. Select the answer from the drop-down menu.

6. (Optional) Click the  Advanced Options button to send question text to Q6RF
remotes, while in presentation mode. Questions can have a maximum of 102
characters, including punctuation and spacing. Click OK when finished.

7. (Optional) Click the Points drop-down menu and select the point value or type in
the desired point value and press the Enter key on the keyboard to apply the point
value to the slide.

8. (Optional) Click the Timer drop-down menu and select the time or type in the
desired time limit and press the Enter key on the keyboard to apply the time to the
slide.
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Numeric

1. Click the  Insert Slide drop-down menu.
2. Select Numeric.  The template appears on the slide.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and

using templates and styles are optional.

4. Click the  Advanced Options button. This brings up the Question Properties
window.

5. Enter the answer/s and point value.
·      Send Question Text to Remotes-check to send question text to Q6RF

remotes. Questions can have a maximum of 102 characters, including
punctuation and spacing.

· Numeric - Select Numeric to add in standard numeric answer/s. (Optional)
Enter in multiple answers and point values to give students partial credit.
(Optional) Check the Convert fractions to numbers box to allow both fraction
and decimal answers  to be counted as correct. If this box is unchecked only
the answer that is typed into the above field will be counted as correct.

· Numeric Range - Select Numeric Range to add an answer for rounding,
number set, algebraic and other problems with a varying answer range.

· Require Precision-  sets a place value to which answer/s need to be rounded.
6. (Optional) Click the Timer drop-down menu and select the time or type in the

desired time limit and press the Enter key on the keyboard to apply the time to the
slide.

Sequence

1. Click the  Insert Slide drop-down menu.
2. Select Sequence and the number of answer choices.  The template appears on the

slide.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and

using templates and styles are optional.

5. Click the  Advanced Options button. This brings up the Question Properties
window.

5. (Optional) Check the Send Question Text to Remotes box to send question text to
Q6RF remotes. Questions can have a maximum of 102 characters, including
punctuation and spacing.

6. Enter in answer and point value.
7. (Optional) Check the Give 1 Point for every item in the correct position box, to apply

partial grading.
8. Click OK when finished.
9. (Optional) Click the Timer drop-down menu and select the time or type in the
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desired time limit and press the Enter key on the keyboard to apply the time to the
slide.

Multiple Mark

1. Click the  Insert Slide drop-down menu.
2. Select Multiple Mark and the number of answer choices.  The template appears on

the slide.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and

using templates and styles are optional.
4. Click in the Answer field and type in correct answer. Press Enter when finished.

5. (Optional) Click the Advanced Options button to send question text to Q6RF
remotes, while in presentation mode or to set partial grading. Questions can have a
maximum of 102 characters, including punctuation and spacing.

6. (Optional) Click the Points drop-down menu and select the point value or type in
the desired point value and press the Enter key on the keyboard to apply the point
value to the slide.

7. (Optional) Click the Timer drop-down menu and select the time or type in the
desired time limit and press the Enter key on the keyboard to apply the time to the
slide.

Rating Scale

1. Click the  Insert Slide drop-down menu.
2. Select Rating Scale and select the type of rating scale.  The template appears on the

slide.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and

using templates and styles are optional.
4. Click in the Answer field and type in correct answer. Press Enter when finished.

5. (Optional) Click the  Advanced Options button to send question text to Q6RF
remotes, while in presentation mode. Questions can have a maximum of 102
characters, including punctuation and spacing.

6. (Optional) Click the Points drop-down menu and select the point value or type in
the desired point value and press the Enter key on the keyboard to apply the point
value to the slide.

7. (Optional) Click the Timer drop-down menu and select the time or type in the
desired time limit and press the Enter key on the keyboard to apply the time to the
slide.
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Short Text Response (For Q5RF and Q6RF remotes only)

1. Click the  Insert Slide drop-down menu.
2. Select Text Input.  The template appears on the slide.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and

using templates and styles are optional.
4. Click in the Answer field and type in correct answer. Press Enter when finished.

5. (Optional) Click the  Advanced Options button to send question text to Q6RF
remotes, while in presentation mode. Questions can have a maximum of 102
characters, including punctuation and spacing.

6. (Optional) Click the Points drop-down menu and select the point value or type in
the desired point value and press the Enter key on the keyboard to apply the point
value to the slide.

7. (Optional) Click the Timer drop-down menu and select the time or type in the
desired time limit and press the Enter key on the keyboard to apply the time to the
slide.

Text Response, Text Edit, and Equation (For Q6RF remotes only)

1. Click the  Insert Slide drop-down menu.
2. Select the type of slide you want to create.  The template appears on the slide.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and

using templates and styles are optional.

5. (Optional) Click the  Advanced Options button to enter answer, send question
text to Q6RF remotes  while in presentation mode, and set partial grading options.
Questions can have a maximum of 102 characters, including punctuation and
spacing.

6. (Optional) Click the Timer drop-down menu and select the time or type in the
desired time limit and press the Enter key on the keyboard to apply the time to the
slide.
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11.3 Participants

Creating a Participant List

1. Click the  Participant button.  The Participant wizard opens.
2. Select Create New Participant List.
3. Enter a name for the participant list and click Next.
5.  Templates are commonly used fields that allow you to quickly add fields to a

participant list. Select a template or click Next to skip this step.

Remote ID is a default column within the templates.  You do not need to
create a field for the Remote IDs, otherwise you will have two Remote ID
columns.

6. In the Participant Field Selection window, add and/or remove the different fields
you would like to use.  If you do not see a field you would like in the participant list,
you can create a customized field. Click Next when finished.

7.  A blank participant list will appear.
8. Fill in the fields and click on Finish.  The Save As window will open.
9. Click Save and the participant list will save as a .QPL file.

Importing a .CSV (Comma Separated Values) File
You can import a .CSV file and convert it into a Qwizdom participant list (.QPL).

If you have a participant list in Microsoft Excel® you would like to import, save
them as .CSV files.

1. Click the  Participant button.  The Participant wizard opens.
2. Select Import/CSV and click Next.
3.  The Open window opens. Browse to the CSV file  and click Open.
4. Match the fields on the left to the fields on the right.  If you don't know what the

field is, select None.
5. If the information on the left are headers, check the First Record is Header box;



Qwizdom Connect User Guide115

Qwizdom Connect 2010

otherwise leave it unchecked.  For example, if the imported information on the left
shows column headers such as Last Name, First Name, Remote ID, etc., those are
headers so you would check the First Record is Header box.  If the information on
the left shows the actual name, Remote ID, etc., uncheck First Record is Header
because those are not headers.

6. Click Next when all the fields have been matched.
7. Click Next.  The participant list will appear.
8. Click Finish and the Save As window opens.
9. Type in the participant list name and click on Save.  The .CSV file will save as a .QPL

file (Qwizdom Participant List).
10. Click Save.  The participant list will be available for you to select when you go into

presentation mode.

Creating an Anonymous List
Before using an anonymous list, be sure you have the correct estimated number of
remotes set within the Configurations Settings window.  For example, if you create an
anonymous list with a hundred participants but only have eighty as the estimated number
of remotes, then not all remotes will register.

1. Open a PowerPoint® presentation (that has been properly formatted with the
Qwizdom Actionpoint toolbar).

2. Click the  Present button.  The Presentation Setup window opens.
3. Click the Participant List drop-down list and select Anonymous.
4. Enter in the number of participants.  The anonymous list has been created.

In Configuration Settings, check to make sure the estimated maximum number of
remotes reflects the number of the participants (or higher).  e.g If you have 32
participants but 24 as the estimated maximum number of remotes, then only 24
remotes will be allowed.

5. Click OK to begin presentation.

Editing an Existing Participant List

1. Click the  Participant button.  The Participant wizard opens.
2. Select Browse and Modify Existing List.

3. Click  Browse.  The Open window opens.
4. Search for the participant list you want to edit.
5. Select it and click Open.  The name of the participant list appears in the Name field.
6. Click Next.  You will be taken to Participant Field Selection.  You may add new fields

or remove existing fields.  If you do not want to change anything, skip to the next
step.

7. Click Next.  The participant list will appear.

You can renumber the remotes according to the order of any column you choose
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by going to Options (in the Participant Wizard window) and selecting Auto number
Remotes.

8. Make the necessary changes and click Finish when done.  The Save As window
opens.

9. Enter the name of the participant list and click Save.
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11.4 Remote Setup

Follow the steps below to set up remotes.  Be sure the HID or RF host* is properly installed
before proceeding.
v.938 host or higher is required for Qwizdom Connect.  If the host is not v.938 host or higher, please contact
Technical Support.

· Estimated Maximum Number of Remotes-the number of remotes that will
be in use for presentation.  Class/group sizes vary, so it's best to enter the
highest estimated amount of remotes rather than accommodating each
class/group.

· Enable Backlight-activates the back light on the Q5RF Participant and Q5RF
Instructor Remotes.

· Fixed Set-select this mode if you are K-12 or Corporate setting. Fixed Set is
where the remotes are assigned with an internal number (assigning fixed
numbers) where logging in by ID is not mandatory.

· Roaming Set or Participant Owned-check this option if the participants own
the remotes. This mode is best-suited for Higher Ed/University settings.
Participants are required to either enter a Session ID or Participant ID to join a
presentation (see Remote Login for more details).

1. Click the  Remotes menu.
2. Enter an estimated number of remotes that will be used.
3. Depending on the setting, select Fixed Set or Roaming Set/Participant Owned.
4. Click OK.
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What is a Session ID?
When using RF Remotes for the first time, the remotes may ask for a Session ID.  Each host
has a unique six-digit Session ID. Session IDs "assign" the remote to the host, allowing the
remote to only communicate with that specific host.

The Session IDs can be found:

· For both HID and RF Host, the Session ID can be found in the Remote Assignments
window, the Login tab in the Presentation Setup window, and the Login tab during
a presentation in the Qwizdom Toolbar.

· For the HID Host, click Qwizdom Tools, found in the lower right hand corner of the
Windows Taskbar (next to the clock). The Session ID will be displayed at the top of
the menu.

· For the RF Host, the Session ID can be found on the bottom of the device on a
white sticker.

You can also create your own Session ID in the Presentation Setup window. Creating your
own Session ID does not change the host's default Session ID. The Session ID must be unique
because if there are other hosts in the same building, the remotes will become confused
about the host with which they are to communicate.

Assigning Fixed Numbers
Assigning fixed numbers assigns the remote ID (e.g. remote #1, remote #2, etc.).  The file that
contains the remote assignments is saved onto the computer, not on the remotes.  You
only have to assign fixed numbers once, unless you change computers or hosts.

1. Be sure the RF host is properly installed before proceeding (v.938 host or higher is
required for Qwizdom Connect. If the host is not v.938 host or higher, please
contact Technical Support).

2. Go to the Remotes menu. The Configuration Settings window appears.
3. Enter the estimated number of remotes that will be in use.
4. Select Fixed Set.
5. Click Assign.  The Remote Assignment window opens.
6. Click the Host drop-down menu and select the COM number (of the host) you will

be using. The Session ID will automatically appear in the Session ID field.
7. Click Start.
8. Turn on the remotes and enter the Session ID.  When the remotes communicate

with the host, the number of the remote (with a remote image) appears in the
window.  The Remote ID will also appear on the remote.

 If remotes have been labeled with numbers, turn on remotes in sequence. Be sure to
wait until the remote has connected to the host before turning on the next remote.

9.  After all the remotes have been assigned, click Stop.
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10. Click OK to save and exit the Remote Assignment window.
11. Click OK to save and exit the Configuration Settings window.

Changing Session IDs
If the RF remote or Tablet displays No Net, Not Found, Not Active, or Inactive, it could be that
the Session ID is not correct.

· For Q2RF remotes: wait for the remote to time out and turn off. When you turn it
back on, press the Help key. When you see --S on the display, it is prompting you for
the Session ID. Enter it and press the Send key to confirm.

· For Q4RF remotes: press the Menu key, use the right arrow to scroll to Sess. ID., and
press the Send (double arrows) key to select the option.  You will see the current
Session ID and will be asked if you want to change the Session ID.  Press T (Yes) to
change.  Enter the Session ID and press the Send (double arrows) key to send.

· For Q5RF remotes: wait for the remote to display No Net, Not Active, or Not Found.
Press the Menu key and select Enter Session ID using the Send (double arrows) key or
the circle key on the thumb pad.  Enter the Session ID and press the Send (double
arrows) key.

· For Q6RF remotes: press the Menu key, scroll to Enter Session ID, press the  menu
select key, re-enter the Session ID, and press the Join key.

· For Q7 Tablet:  press the Menu key and use the Scroll button to select Enter Session
ID. Press the Enter key to select it and enter the Session ID. Press the Enter key to
confirm.
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11.5 Presentation

Before presenting a PowerPoint® presentation using Qwizdom remotes, please see
Presentation Setup to learn about the presentation features.

1. Click the  Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Select the options you would like available during presentation in the General,

Login, and Chart tabs in the lower part of the Presentation Setup window.
6. Click OK to begin the presentation.

If you present using the PowerPoint® Slide Show options, Qwizdom remotes will

not activate.  You must present the slides by clicking on the  Present button
to use Qwizdom remotes.

7. Have the participants turn on their remotes.
8. Either the answer choices or a blank screen appears on the remote, depending on

the question type.

Here are a few things you may execute during presentation:
· Display the response chart (see Response Graph for details).
· Display the private graph.
· Randomly call upon a participant.
· Pose a spontaneous question (see Posing Spontaneous Questions for

details).

 See Using Remotes in Presentation for instructions on use and troubleshooting of
all the remote LCD screen messages.
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9. Go through the presentation until all the question slides are answered.
10. When you are unable to advance to the next slide, this means the presentation is

done.  Press the circle key in the thumb pad to stop the presentation (screen will go

black) and press it again to exit back to PowerPoint®.

11.5.1 Presentation Setup

There are many options you can apply to your presentation. Not all options will be
applicable.

General tab:
Send Right/Wrong Feedback to Remotes after answering-remotes will receive a check
mark if answer is correct and an X if answer is incorrect. Remotes will receive both a
check mark and X to indicate that the response has been received, if feedback is turned
off.
Allow participants to change answer-allows participants to change their answer for
the current question slide.
Override Points Value with Global Point value of --- points-enters the new amount of
points that will be temporarily applied to the slide for that presentation.
Timer-you can select no timer, use the time set within the slides, or global timer by
entering the number of seconds for all slides in the presentation.
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Login tab:
Require Login by ID-remotes prompt participants to enter their Participant ID.
Show Login Screen-displays the login screen so the instructor can view the participants
that are logging in.
Add & Allow Unregistered participants-participants will be added to the participant
list by logging in with their Participant ID. This option must be checked when using an
Anonymous list. For the Anonymous list, participants will only log in with the Session ID.
Deny Login After --- minutes-logins after the set amount of time will not be accepted.
Use Virtual Remotes--feature coming soon

Chart tab:
Automatically Show Correct Answer on Chart-displays a fraction and percentage of
correct answers. For example: Correct Answer(s) 10/12 83%.
Background Filename-selecting this option will allow you to select an image to display
as the response chart background.
Select Graph Layout-selects how the response chart will be displayed during
presentation.
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Advanced Settings
In the Presentation Setup window, go to File and select  Advanced Settings. This will bring up
the Advanced Settings window.

Advanced Settings
· Allow Instructor to go back to a previous slide-allows the Q5RF Instructor Remote

and Q7RF Tablet to move back to a previous slide.
· Reset Com-Port When Starting Presentation-this option is checked by default to

ensure the host activates when presentation begins.
· Ask for confirmation of User ID when not on list-the remote will prompt the

participant for the user ID again, if the participant is not in the participant list that is
loaded.

· Use Audio Feedback when using Tablet Keys-when using the Tablet, the computer
will emit a beeping sound as a notification that the Pen and Tablet are
communicating.

Advanced Hardware Settings
· Don't require "Send" on single key answers-the remote will automatically send the

answer once it has been entered.
· Disable "Change UserID" menu during Login-hides the User ID option from the

menu.
· Disable "Change SessionID" menu during Login-hides the Session ID option from the

menu.
· Disable "Change UserID" menu during active Session-hides the User ID option from

the menu during presentation.
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· Disable "Change SessionID" menu during active Session-hides the Session ID option
from the menu during presentation.

· Do not show what key was pressed on Q2's-does not show the key that is pressed on
the display.

· Turn off remotes on presentation end-automatically turns off the Q2RF and Q4RF
remotes when a presentation ends.

· Show score on Remote in Self-Paced Mode-checking this option displays the
participant's score on the remote when the participant has completed the answer
key.

11.5.1.1 Presentation Settings

Presentation settings can be saved and loaded (onto the same computer or another
computer) into the Presentation Setup window of Actionpoint, Answer Key, and Question Bar
applications.

Saving Presentation Settings
1. In the Presentation Setup window, select the options you would like during

presentation.
2. Go to the File menu and select Save Settings. The Save As window appears.
3. Enter the name for the selected settings.
4. Click Save. The settings will save as a .CFG file in the location you selected.

Loading Presentation Settings
1. In the Presentation Setup window, go to the File menu.
2. Select Load Presentation Settings. The Open window appears.
3. Select the saved settings file (.CFG) and click on Open.
4. The current settings in the Presentation Setup window will change to the settings

you selected to load.

11.5.1.2 Remote Login

Logging in with IDs allows participants to use any remote.  If you use Participant IDs from a
participant list, the ID will link the remote to the participant's information in the list.

To have participants log in, they must have a Participant ID.  Participant IDs are set up
when creating participant lists.  (Go to Participant Lists for more information).  Each
participant should have a unique ID assigned to their name.

· Participant IDs can only be numeric.
· The maximum number of digits allowed for IDs using the Q2RF remotes is 8.
· The maximum number of digits allowed for IDs using the Q4RF remotes is 9.
· The maximum number of digits allowed for IDs using the Q5RF remotes is 8.
· The maximum number of digits allowed for IDs using the Q6RF remotes is 15.
· IDs cannot be used for more than one participant (IDs cannot be duplicated).

1. Open a PowerPoint® presentation or create one to present.
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2. Click the  Present button.  The Presentation Setup window opens.
3. Select a participant list from the Participant List drop-down menu.
4. Click the Login tab.
5. Check the Require Login by ID option.
6. Checking the Show Login Screen is optional.
7. Select all other preferred options and click OK to present.  The presentation will

begin.
8. The Q4RF, Q5 RF and Q6RF remotes will display User ID.  The Q2RF remotes will

display --U.
9. Participants will enter their ID and press the Send key.
10. Once everyone has logged in, begin the presentation.

You can start the presentation as participants log in. Participants who are late can log in
later if you have not set a timer to deny log in.

Login Timer
You can deny login after a certain amount of time by setting the time under the Login tab.

1. Check the Deny Login After --- Minutes option.
2. Enter the number of minutes that participants have to log in.

For example, you have selected to deny log in after 5 minutes. After 5 minutes have
passed, participants who try to log in will be denied.

Logging in with Participant IDs
Participant IDs can only be numeric.

1. Click the  Present button.  The Presentation Setup window opens.
2. Click the Login tab.
3. Select Require Login by ID.
4. Select the participant list and any other options you want to apply to the

presentation.
5. Click OK to begin the presentation.
6. The Q4RF and Q5RF remotes will display User ID. The Q2RF remotes will display --U.
7. Enter the Participant ID and press the Send key.
8. If the Q4RF remote displays Denied, or the Q5RF remote displays Access Denied, or

the Q2RF remote displays --U, then the Participant ID may have been entered
incorrectly.

· For Q2RF remotes, press the Hand key, re-enter the Participant ID, and press
the Join key.

· For Q4RF remotes, press the Menu key, use the right arrow to scroll to User ID,
and press the Send (double arrows) key to select it.  Re-enter the Participant
ID and press the Send (double arrows) key.

· For Q5RF remotes, press the C (clear) key, re-enter the Participant ID, and
press the Send (double arrows) key.

The Participant IDs will be remembered for the session until another participant list is
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selected.

11.5.1.3 Presentation Queue

Presentation queues are only for Actionpoint using PowerPoint® presentations.

Use Presentation Queue

1. Click the  Present button. The Presentation Setup window appears.
2. Go to the File menu and select Use Presentation Queue. The Presentation Queue

window appears.
3. Click Add. The window will change to show three fields: Presentation, Participant

List, and Results.
4. Click the Presentation Browse button. The Open window appears.
5. Select the presentation and click Open.
6. Click the Participant List Browse button.  The Open window appears.
7. Select the participant list and click Open.
8. Click the Results Browse button. The Save As window appears.
9. Select a location where the results will be saved.
10. Enter a name for the results and click Save.
11. Click Add.  You will be taken back to the Presentation Queue window and see the

files you just added.
12. Repeat steps 4-12 to add another presentation.
13. When you are finished creating your queue, click Save Queue. The Save As window

appears.
14. Select a location where you would like to save the queue.
15. Enter a name for the queue and click on Save.
16. Click OK. You will be taken back to the Presentation Setup window.
17. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
18. Click the Saved Results drop-down arrow and select how you would like to save the

results.
19. Select the options you would like available during presentation in the General,

Login, and Display tabs in the lower part of the Presentation Setup window.
20. Click OK and the queue will start.
21. When the first presentation is complete, exit presentation mode.
22. The results will save as a .QRX file in the selected location with a designated name.
23. The second presentation will begin, on its own, in a few moments.

This process will repeat depending on how many presentations are set in the queue.
Results will be generated after each presentation is closed upon completion.

Loading a Saved Presentation Queue

1. Click the  Present button. The Presentation Setup window appears.
2. Go to the File menu and select Use Presentation Queue. The Presentation Queue
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window appears.
3. Click Load Queue. The Open window appears.
4. Select the queue you want to use and click Open. The files appears in the

Presentation Queue window.
5. Click OK and you will be taken back to the Presentation Setup window.

11.5.2 Presentation Features

Qwizdom Toolbar
There are many ways to customize your Qwizdom presentation tools. Right-click on the
Qwizdom Toolbar to view options.

Buzz-In Box/Participant Counter
The Buzz-In Box displays the percentage of participants who have answered.

During a presentation:
1. Right-click the Qwizdom Toolbar and go View/Buzz-in Box.
2. Click the Buzz-In Box to change the indicator view from percentage to fraction.

Answer Grid
 The Answer Grid indicates participant response by corresponding remote ID numbers.

To Show/Hide the Answer Grid.
1. Right-click the Qwizdom Toolbar and go View/Answer Grid.
2. Right-click Answer Grid to change display settings, including size, number of

columns, placement, etc.

Qwizdom Tools
Includes three presentation tools including , the Response Graph, Pick, Re-pose, and
Game/Show. Use when presenting activities without the Q5RF Instructor remote or the
Q7RF Presenter Tablet.

Response Graph

1. Click the   Response Graph button.
2. The Response Graph appears.
3. Click the available chart(s) to view the results.
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4. Double-click the title bar of the window to display the graph in full screen.

Picking Participants

1. Click the  Pick button to randomly call upon a participant.
2.  The participant's name appears on screen.

3. Click the  Pick button again to remove the name.

Re-posing a Question
Re-posing is used to ask a question again and/or  when you accidentally skip a slide that
needs to be answered. Re-posing the question overwrites the previous responses if any are
recorded.

1. Click the   Re-pose button to ask the question on the slide again.

Game/Show

1. Click the  Game button to view game windows, including scores, animations,
etc.

Automatically Show Correct Answer on Chart
Displays a fraction and percentage of correct answers on the response graph. For example:
Correct Answer(s)10/12 83%.

1. Right-click the Qwizdom Toolbar and select Setting.
2. Under the Display tab,  select Automatically Show Correct Answer on Chart.

Timer
You can set the timer two ways; use the time from each slide or apply a new time during
the presentation.
To set a new time to the presentation:

1. Right-click the Qwizdom Toolbar and select Setting.
2. Under the Display tab,  check the Show Timer box. Select Use Global Timer Value of---

from the Timer drop-down menu.
3. Enter the number of seconds.
4. Click OK to close presentation options and apply changes.

To quickly view or hide Timer, right-click the Qwizdom Toolbar and go
View/Timer.

Points
You can set the point value two ways: use the point value from each slide or apply a new
point value to all the questions in the presentation.  When you create a slide, you enter the
number of points the correct response will be awarded.  Go to Creating a Slide for more
information.
To apply a new point value to all the questions in the presentation:
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1. Click the  Present button. This brings up the Presentation Setup window.
2. Check the Override Point Value with Global Point value of --- points option in the

General tab.
3. Enter the number of points.
4. Click OK to present the presentation with the newly set number of points.

Right/Wrong Feedback
This allows participants to see if their response is right or wrong.  Feedback appears on the
LCD screen of the participant's remote during presentation.  A check mark will indicate a
correct response, an X will indicate an incorrect response. If the feedback is disabled, a
check mark and X appears on the LCD screen, indicating that a response was received.

1. Click the  Present button. This brings up the Presentation Setup window.
2. Check the Send Right/Wrong Feedback to Remotes after answering box in the General

tab.

11.5.2.1 Response Graph

During presentation, you can display a response graph to see the results of the question.
There are two response graphs you can display: the public response graph and the private
graph.

Public Response Graph using no Instructor Device
1. Click the   Response Graph button located on the Qwizdom Tools bar. See

Presentation Features for details.

Public Response Graph using the Q7RF Tablet
1. Press the  Public Graph icon on the Q7RF Tablet.
2. The response graph appears on the computer screen.

3. Press the  Public Graph icon on the Q7RF Tablet again to close the response
graph.

If you have a graph displayed, either on the Q7RF Tablet or computer, you must
first remove that graph before displaying the private response graph and/or
move onto the next question.

Private Response Graph using the Q7RF Tablet
1. Press the  Private Graph icon on the Q7RF Tablet.
2. The response graph will display on the Q7RF Tablet's LCD.

3. Press the  Private Graph icon on the Q7RF Tablet again to close the response
graph.
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Public Response Graph using the Q5RF Instructor Remote
1. Press the / key on the Q5RF Instructor Remote.
2. The response graph appears on screen for the participants to view.
3. Press the right/left arrows to view a different graph of the results.
4. Press the / key again to remove the response graph.

If you have a graph displayed, either on the Q5RF Instructor Remote or computer,
you must first remove that graph before displaying the private response graph
and/or move onto the next question.

Private Response Graph using the Q5RF Instructor Remote
1. Press the 0 key on the Q5RF Instructor Remote.
2. A bar chart showing the number of responses will display on the Q5RF Instructor

Remote's LCD screen.
3. Press the 0 key again to remove the graph.

Bar Chart
Displays results as a bar chart. Click or press the Bar Chart to change the bars from
horizontal to vertical.

Press the circle key to show bars horizontally or vertically.
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Pie Chart Displaying Correct Answer with Number of Responses
Displays results as a pie chart with numbers and the correct response. Click on actual pie
chart to show results as whole or in sections.

Pie Chart Displaying Correct Answer with Percentages
Displays results as a pie chart with percentages and the correct response. Click on actual
pie chart to show results as whole or in sections.
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Pie Chart Displaying Number of Responses
Displays results as a pie chart with numbers. Click on actual pie chart to show results as
whole or in sections.
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Pie Chart Displaying Percentage of Responses
Displays results as a pie chart with percentages. Click on actual pie chart to show results as
whole or in sections.
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List View Chart
Displays results in the order it was received by Remote ID, Participant ID, Participant Name,
their response, how long it took for the response to be received, and if their response was
correct.
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Scores Chart
Displays results by Remote ID, Participant ID, Participant Name, points, and their current
percentage (which is accumulative) for the presentation.

11.5.3 Games

Actionpoint and Connect both offer the Qwizdom games.

There are different ways in displaying the game animations during presentation:

Actionpoint

· Using computer mouse there is  a  Game button in the Qwizdom Toolbar.  Click
to display the game screens and animations.

· Tablet-press the  Show Presentation button.
· Q5RF Instructor-press the 7 Show key.

Connect
· Using computer mouse-click the right arrow in the Presentation toolbar to advance

to the next slide.

· Tablet-press the   Show Presentation or advance to the next slide.
· Q5RF Instructor-press the right arrow key.

Baseball
Two teams are needed to play Baseball, which the program will automatically group by
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remote numbers: odd number remotes vs. even number remotes. The outcome of the
game depends on the number of correct responses of each team for each question.

1. Click the  Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Click the Presentation drop-down arrow and select Baseball.
6. Select the options you would like available during presentation in the General,

Login, and Chart tabs in the lower part of the Presentation Setup window.
7. Click OK to start the presentation.
8. The Baseball setup window will display the odd and even remote numbers in their

respective teams.
9. A batter appears, followed by a question slide.
10. Participants will send in their responses.
11. The outcome of each play is determined by the number of responses from each

team. The game will go in favor of the team with the most correct responses in the
least amount of time.

12. The winning team will be displayed when all questions have been answered or
when the game has been manually ended.

Fast Track
Fast Track is a race car game in which points are rewarded based on the response time of
each remote.

1. Click the  Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Click the Presentation drop-down arrow and select Fast Track.
6. Select the options you would like available during presentation in the General,

Login, and Chart tabs in the lower part of the Presentation Setup window.
7. Click OK to start the presentation.
8. A question slide appears.
9. Participants will send in their responses.
10. Points are awarded by correct responses sent in the least amount of time.
11. The winner will be displayed when all questions have been answered or when the

game has been manually ended.
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Mission to Mars
Mars Mission is a space ship game in which points are rewarded based on the response
time of each remote.

1. Click the  Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Click the Presentation drop-down arrow and select Mars Mission.
6. Select the options you would like available during presentation in the General,

Login, and Chart tabs in the lower part of the Presentation Setup window.
7. Click OK to start the presentation.
8. A question slide appears.
9. Participants will send in their responses.
10. Points are awarded by correct responses sent in the least amount of time.
11. The winner will be displayed when all questions have been answered or when the

game has been manually ended.

Quandary
Quandary is a Jeopardy-like game where users select various dollar amount questions from
a game board. 25 slides (questions) are recommended in order to fill the game board.

1. Click the  Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list

you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the

results.
5. Click the Presentation drop-down arrow and select Quandary.
6. Select the options you would like available during presentation in the General,

Login, and Chart tabs in the lower part of the Presentation Setup window.
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7. Click Settings. The Quandary Configuration window appears. Quandary
Configuration is where the game options are set up for presentation.

8. Enter the name of each topic. Each topic represents a category of questions.
9. Enter the slide numbers related to the particular topic. Each slide represents a

different dollar amount in each category (starting from 100 to 500).
10. Select the scoring option for the game.
11. You can use pre-existing groups (created in the Participants tab) or have the game

create temporary groups (which the program will assign) for the current
presentation.

12. Click OK. You will be taken back to the Presentation Setup window.
13. Click OK to start the presentation.
14. The Team Members screen appears displaying remote numbers in each group.
15. Press or click 1 Categories to start the game.
16. The game board will display with the categories and dollar amounts.
17. Select a dollar amount from a category. A question slide appears.
18. Participants will use the remotes to send in their responses.
19. Team points are based on the number of correct responses from each team

member. Individual scores are based on how fast the user was able to send in the
correct answer because the first remote to send in the correct answer receives all
the points for that question.

20. The winning team will be displayed when all questions have been answered or
when the game has been manually ended. The individual winner can be
determined in the Player Scores screen.
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11.6 Reports

You can generate reports* using existing saved results. *Registered  version of Microsoft Excel® is
required to generate reports.

1. Click the  Reports button.  The Reporting Wizard window opens.

Reports and Features
· Answer Report-displays the class average score bar chart, participant question

responses, correct answers, and scores.
· Answer Distribution Report-displays total percentage of responses for each question

with correct answer and bar chart.
· Score Report-displays participant information with various point totals and scores.
· Question Summary Report-displays a thumbnail preview of each question within an

activity with a bar chart indicating question responses next to each question.
· Standards by Question Report-displays the standards that are linked to the

questions (activity).
· Standards Mastery Report-displays percentage of class that met each standard in

the activity.
· Participant Detail Report-displays participant information.
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· Participant Group Overview Report-displays participant group information.
· Attendance Report-displays participant information with their remote login time.

· Participant Comparison Report-displays a comparison of the participant's
question responses, correct answer, and score to the whole class' results.

· Student Question Summary Report-displays a thumbnail preview of each
question within an activity with answer details next to each question, including
correct answer, participant response, class percentage, and mode.

· Student Standards Report-displays how the individual participant met each
standard in the activity.

Flash Reports
· Question Summary (with Answer)-based report displays each question slide with

response charts, marking the correct answer in green.
· Question Summary (without Answer)-based report displays each question slide

with response charts.
· Answer Report -displays each question slide with the user's response and the

correct answer.

Export:
· Convert to .CSV-convert .QRX file to .CSV.

Options:
· Override the Point value of all slides to be --- points-overrides point value that was

awarded during presentation.

2. Click Browse to search for the file for which you want to generate a report.  The
Open window opens.

3. The file type will be .QRX.  Search for the file and select it.
4. Click Open.
5. Select the type of report you want to generate and click Generate.
6. This will launch the Report Viewer window. View, print, and export reports.

11.6.1 Saving Results

All results are saved as an .QRX file but can be converted into a .CSV (Comma Separated
Values) file.

Manual Save

1. Click the  Present button.  The Presentation Setup window opens.
2. Select Browse for Save Location.
3. Click  Browse. The Save As window appears.
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4. Select a location in which to save the results.
5. Enter the name with which you want the results to be saved.
6. Click Save.  The file name and location appears in the Save Results field.
7. The results will save in the selected location.

Auto-save

1. Click the  Present button.  The Presentation Setup window opens.
2. Select Auto Save as 'Filename + List + Date.'
3. The Browse for Folder window appears.
4. Select the location and click OK.
5. The file name will contain the location, name of the participant list, date, and time

under the Save Results field.
6. The results will save when the presentation is complete.

Auto-Save to Results Manager (Recommended)

1. Click the  Present button.  The Presentation Setup window opens.
2. Select Auto Save to Results Manager.
3. The results will save in the Results/Reports window when the presentation is

complete.
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12 Question Toolbar

Question Toolbar allows you to turn any activity into an interactive presentation. This
floating toolbar appears over any application (including web pages, written documents,
lessons, slide shows, etc.) allowing you to ask verbal questions or create content on-the-fly,
while students respond in using student remotes.  You may choose to save results to
assess student understanding or simply save your presentations.

    

1. Go to the Programs menu and select  Question Toolbar. The Presentation Setup
window appears.

2. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.

3. Click the Saved Results drop-down arrow and select how you would like to save the
results.

4. Select the options you would like available during presentation in the General,
Login, and Display tabs in the lower part of the Presentation Setup window. See
Presentation Setup for details.

5. Click OK to begin the presentation.
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6. Have the participants turn on their remotes.
7. Ask verbal questions/or create content on-the-fly. Use either your desktop, laptop,

or Q7 Presenter Tablet to create slides and pose questions.
8. (Optional) Open up any computer program, application, graphic, etc  you wish to

use in your presentation.
9. Select a question type from the Type menu (Multiple Choice, True/False, Yes/No,

etc).
10. Choose the correct answer.

11. (Optional) Click the   Advanced Options button to send question text to Q6RF
participant remotes only or set partial grading options.

12. (Optional) Set points and timer.

13. Click the  Pose button to send the question to the participant remotes. A screen
capture of your desktop will be made into the background of your presentation.

14. Once all participants have answered click the  Stop Pose button.
15. (Optional) Click the public graph button on the Qwizdom Toolbar, Q5RF, or Q7RF

Presenter Tablet to view results graph. See Presentation Features for more
information on presentation options.

16. Click the right-arrow to create and pose another question. 

17. When you are finished presenting, click the  Utilities button and select Exit.
18. A window appears prompting you to Rename, Delete, or Leave the activity name.
19. Choose Rename and enter a name for the activity. The activity appears in the tree of

the Content Manager.
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13 Settings/Preferences

Go to the File menu and select Preferences. The Preferences window appears.

General Tab
· Auto-start Qwizdom Connect on system start up-checking this option will open

Qwizdom Connect when your computer starts up.
· Auto-login to Qwizdom Connect-automatically logs in with your username and

password when Qwizdom Connect is opened. When this option is checked, you will
be prompted to enter your username and password to store for the auto-login
process.

· Auto-upload results to Qwizdom Connect-must be logged in to enable results to be
automatically uploaded to the Results/Reports window of Qwizdom Connect.

· Auto Group Results Files-auto groups results files in folders.
· Software version number - helpful information to give support technicians when

requesting help.

Proxy Tab
· I do not have a proxy -- this is used when you are not behind a proxy and/or your

proxy does not require authentication. This is currently the default
· Use my computer settings -- this means use the proxy settings that are already

configured on my machine.
· Specify custom settings -- this allows you to specify a custom proxy server and/or

credentials to authenticate with against the proxy server.
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14 Qwizdom Online

Qwizdom Online enables you to access online content and media to preview and
download. Registration must be completed in order to use any of Qwizdom Connect's
online features. See Online Registration for details.

1. Go to the Login menu and type in your username and password.
2. Click the Qwizdom Online tab in the application window.
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14.1 Online Search

There are multiple ways to search for activities, multimedia,etc .Certain activities and
curriculum packages require a product code (license), which can be acquired through the
purchase of Qwizdom Connect Premium Service. Restricted content may be previewed but
not downloaded.

 Indicates Restricted Content.

Activities that are downloaded from the online search are saved into Qwizdom
Connect. To view all recently downloaded activities, click on the Content tab, and open
the Recently Added folder in the Content Tree.

Keyword Search
1. Click the Qwizdom Online tab.
2. Enter keyword/s into the Keywords field.
3. Click Search.
4. Activities, documents, and multi-media materials will appear.
5. Preview, Recommend, Download, etc curriculum and materials.

Browse Collections
1. Click the Qwizdom Online tab.
2. Click the Browse Collections. This allows you to view multiple lessons and activities

within a package.
3. Select Subject, Grade, and Package to view content.
4. Preview, Recommend, Download, etc curriculum and materials.

Browse by Standards
1. Click the Qwizdom Online tab.
2. Click the Browse by Standards. This allows you to view multiple lessons and

activities by state standards.
3. Select Subject, Grade, and Package to view content.
4. Preview, Recommend, Download, etc curriculum and materials.
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14.2 Share Content

1. Go to the Login menu and enter  your username and password. (See
Online Registration to create a username and password. )

3. Click the Connect Online  tab.
3. Click on Share .
4. Fill out the form and click the Submit button when finished.
5. This brings up the My Page window. Click on the Uploads bar to view your recently

uploaded materials and status (pending or complete).
6. When the content has been successfully uploaded, a preview or icon will appear

with a description of the item.

To quickly find your recently uploaded item, select Most Recent in the Sort By
drop-down menu.

7. You can Preview Content, Recommend, Download, Edit ,or Remove  your uploaded
content.
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14.3 My Page

1. Go to the Login menu and enter your username and password. (See
Online Registration to create a username and password. )

2. Click the Connect Online  tab.
3. Click on My Page.

4. Click Uploads to view all your recently uploaded items.
5. Click Downloads to view all of your downloaded items.
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14.4 Online Reporting

Must have Premium B to access the following features and options. Please contact Sales at 877-
794-9366 for ordering information.

Teachers and administrators have the ability to view district, school, class, and student
reports by score, performance comparison across schools, activities, demographics,
standards mastery, and skills. All these reports provide instant student performance data,
enabling teachers to quickly identify specific needs and follow up with modified
instruction.

14.4.1 Managing Sites

Must have Premium B to access the following features and options. Please contact Sales at 877-
794-9366 for ordering information.
Creating a Site

1. Login with your username and password in the Qwizdom Online tab or the Login
menu.

2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete Site.
5. Click Next.
6. Select Create New Site.
7. Enter a name for the site.
8. Click Next.
9. Fill out the fields (optional).
10. Click Next when finished.

Updating a Site
1. Login with your username and password in the Qwizdom Online tab or the Login

menu.
2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete Site.
5. Click Next.
6. Select Update Site.
7. Click the Site drop-down arrow and select the site you want to update.
8. Click Next.
9. Update the site information.
10. Click Next when finished.

Deleting a Site
1. Login with your username and password in the Qwizdom Online tab or the Login
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menu.
2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete Site.
5. Click Next.
6. Select Delete Site.
7. Click the Site drop-down arrow and select the site you want to delete.
8. Click Next when finished.

14.4.2 Managing Online Classes

Must have Premium B to access the following features and options. Please contact Sales at 877-
794-9366 for ordering information.
Creating an Online Class

1. Login with your username and password in the Qwizdom Online tab or the Login
menu.

2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete a Class.
5. Click Next.
6. Select Create New Class.
7. Enter a name for the class.
8. Click Next.

There are two ways to add participants: add a new participant or add participants from an
existing QPL.

· To add participants from an existing list, click the Add Students from Existing QPL. The
Select Participant List window appears. Select the QPL you want to import from the
Registered Participant Lists drop-down arrow and click OK. Registered participant lists
are the local QPLs listed in the Participants Tree; or to import a QPL outside of the
Participants Tree, click Select Other Participant List. An Open window opens. Select the
QPL you want to import and click Open.

· To add a new participant, click Add New Student. A new row appears for you to enter
information.

9. When the participants have been added, click Create Class.
10. Click Next when finished.

Updating an Online Class
1. Login with your username and password in the Qwizdom Online tab or the Login

menu.
2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete a Class.
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5. Click Next.
6. Select Update Class.
7. Click the Class drop-down arrow and select the class you want to update.
8. Click Next when finished.

Deleting an Online Class
1. Login with your username and password in the Qwizdom Online tab or the Login

menu.
2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete a Class.
5. Click Next.
6. Select Delete Class.
7. Click the Class drop-down arrow and select the class you want to delete.
8. Click Next when finished.

14.4.3 Managing Users

Must have Premium B to access the following features and options. Please contact Sales at 877-
794-9366 for ordering information.
Creating a User

1. Login with your username and password in the Qwizdom Online tab or the Login
menu.

2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete a User.
5. Click Next.
6. Select Create New User.
7. Enter a username for the user.
8. Click Next.
9. Fill out the fields with the user's information.
10. Click Create.
11. Click Next when finished.

Updating a User
1. Login with your username and password in the Qwizdom Online tab or the Login

menu.
2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete a User.
5. Click Next.
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6. Select Update User.
7. Click Next.
8. Select and enter the search criteria.
9. Click Search.
10. When the search results appear, select the user(s) you want to update.
11. Click Next.
12. Update the user's information.
13. Click Update when finished.

Deleting a User
1. Login with your username and password in the Qwizdom Online tab or the Login

menu.
2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete a User.
5. Click Next.
6. Select Delete User.
7. Click Next.
8. Select and enter the search criteria.
9. Click Search.
10. When the search results appear, select the user(s) you want to delete.
11. Click Delete Selected Users. A prompt appears stating the user(s) have been deleted.
12. Click Next when finished.

14.4.3.1 Bulk XML Import

Must have Premium B to access the following features and options. Please contact Sales at 877-
794-9366 for ordering information.

1. Login with your username and password in the Qwizdom Online tab or the Login
menu.

2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Bulk XML Import/Export.
5. Click Next.
6. Click Select File. The Open window appears.
7. Select the XML file you want to import and click Open. The name of the bulk XML

file appears in the Select the Bulk XML file field.
8. Click Submit.
9. Submission Complete appears when the XML file has been successfully uploaded.
10. Click Next to finish.

Bulk XML Import Template
Use this template to create bulk XML files to upload into Qwizdom Connect.
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<?xml version="1.0" encoding="utf-8"?>
<ImportData>

<Templates>
<ClassName>{Name}</ClassName>
<TeacherUsername>{TUsername}</TeacherUsername>
<TeacherPassword>{TPassword}</TeacherPassword>
<StudentUsername>{SUsername}</StudentUsername>
<StudentPassword>{SPassword}</StudentPassword>

</Templates>
<Schools>

<School>
<Status>ADD</Status>
<SchoolID>5000</SchoolID>
<Name>Test School A</Name>
<Address1>Address1-A</Address1>
<Address2>Address2-A</Address2>
<City>Tacoma</City>
<State>WA</State>
<Zip>98404</Zip>
<Email>testschoolA@qwizdom.com</Email>
<Phone>123-456-7890</Phone>
<Fax>098-765-4321</Fax>
<WebSite>www.qwizdom.com</WebSite>

</School>
</Schools>
<Teachers>

<Teacher>
<Status>ADD</Status>
<TeacherID>5001</TeacherID>
<SchoolID>5000</SchoolID>
<FirstName>Teacher Test A</FirstName>
<LastName>Test A</LastName>
<MiddleName>A</MiddleName>
<Email>TestA@Qwizdom.com</Email>
<Sex/>
<CurrentGradeLevel/>
<BirthDate/>
<Demographics/>
<WorkPhone/>
<MobilePhone/>
<HomePhone/>
<Address1/>
<Address2/>
<AptNumber/>
<Notes/>
<Image/>
<TUsername>teacherTestA</TUsername>
<TPassword>password</TPassword>

</Teacher>
</Teachers>
<Students>

<Student>
<Status>ADD</Status>
<StudentID>5002</StudentID>
<SchoolID>5000</SchoolID>
<FirstName>Student Test A</FirstName>
<LastName>Test A</LastName>
<MiddleName>A</MiddleName>
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<Email/>
<Sex>M</Sex>
<CurrentGradeLevel>9</CurrentGradeLevel>
<BirthDate>1992-09-05</BirthDate>
<Demographics/>
<WorkPhone/>
<MobilePhone/>
<HomePhone/>
<Address1/>
<Address2/>
<AptNumber/>
<Notes/>
<Image/>
<SUsername>030146</SUsername>
<SPassword>sep05</SPassword>

</Student>
</Students>
<Courses>

<Course>
<Status>ADD</Status>
<CourseNo>5003</CourseNo>
<SchoolID>5000</SchoolID>
<Period/>
<SectionNo/>
<TeacherID>5001</TeacherID>
<Name>Test Class A</Name>
<CourseID>99305</CourseID>
<SchoolYear>2008</SchoolYear>
<Term/>
<Participates>

<Participate>
<Status>ADD</Status>
<StudentID>5002</StudentID>

</Participate>
</Participates>

</Course>
</Courses>

</ImportData>

14.4.4 Managing Distribution Groups

Must have Premium B to access the following features and options. Please contact Sales at 877-
794-9366 for ordering information.
Creating a Distribution Group

1. Login with your username and password in the Qwizdom Online tab or the Login
menu.

2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete a Distribution Group.
5. Click Next.
6. In Create New Group, enter a name.
7. Click Create.
8. Now, you will need to add users to the distribution group.
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9. Click Add New Members.
10. Select and enter the search criteria.
11. Click Search.
12. When the search results appear, select the user(s) you want to add to the

distribution group.
13. Click Next when finished.

Updating a Distribution Group
1. Login with your username and password in the Qwizdom Online tab or the Login

menu.
2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select Create, Update, or Delete a Distribution Group.
5. Click Next.
6. Click the Select Group drop-down arrow and select the distribution group you want

to update.
7. To remove a user from the distribution group, select the user's row and press the

Delete key on the keyboard.
8. To add users to the distribution group, click Add New Members.
9. Click Next to finish.

Deleting a Distribution Group
1. Login with your username and password in the Qwizdom Online tab or the Login

menu.
2. Go to the File menu.
3. Select Manage Qwizdom Connect Online. The Qwizdom Connect Online Management

window appears.
4. Select "Create, Update, or Delete a Distribution Group.
5. Click Next.
6. Click the Select Group drop-down arrow and select the distribution group you want

to delete.
7. Click Remove Selected Group. The distribution group will be deleted.
8. Click Next when finished.
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15 Qwizdom Tools

Qwizdom Tools are located in the lower-right hand corner of the Windows Taskbar (next to
the clock). Qwizdom Tools is a tray application, set to launch automatically on system
startup, allowing shortcuts to areas of the program and users to utilize features on the
Tablet without launching other Qwizdom software applications like Qwizdom Connect or
Qwizdom Actionpoint.

Customizing Qwizdom Tools
1. Right-click  Qwizdom Tools.
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2. Select Preferences.

3. The Preferences window appears.

4. Select shortcuts you want displayed in the list and deselect shortcuts that you
want to remove from the list.

5. Click OK when finished.

6. Changes take affect immediately.
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Setting Up Qwizdom Tools
1. Right-click  Qwizdom Tools.

2. Select Preferences.

3. The Preferences window appears.

4. Check the "Launch Tray on Startup" to automatically start Qwizdom Tools on
computer startup.

5. Click OK when finished.
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15.1 Hot-Key Editor

Hot-Key Editor allows you to dedicate actions that are taken specific to the current active
application. The Hot-Key Editor controls the default commands for the soft-keys on the
Tablet, allowing users to customize some of the default commands and set up alternate
commands that are automatically used with other applications.

1. Right-click  Qwizdom Tools.

2. Select Utilities.

3. Select Hot-Key Editor. Hot-Key Manager opens.
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List of Actions
These are the actions that can be set for the Hot Key Editor.

· None
· Open Application
· Open File
· Open Website
· Keystroke
· Keystroke: CTRL +
· Keystroke: ALT +
· Keystroke: CTRL + ALT +
· Keystroke: CTRL + SHIFT +
· Keystroke: ALT + SHIFT +
· Keystroke: CTRL + ALT + SHIFT +

Editing a Key
Soft-keys can be customized to perform specific commands.

1. Click the List Hot-Keys for drop-down list and select the program you want to edit
the keys for:

· Default is Connect: keys 2-8, 19
· MS PowerPoint is Actionpoint: keys k-13, 16, 19
· Add New Application: when you add an application, it will be keys 2-13, 16, 19,

32-43, 46, 49

2. Select a key number.
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3. Click the Edit button. The Hot-Key Editor opens.

4. Click the Action Type drop-down list and select the keystroke you want to associate
the Action Name (key) with.

5. Then, enter in the character in the field below.

6. Click OK to confirm the key assignment.

Exporting (Saving) a Hot-Key Configuration File
You can transfer the Hot-Key configuration file to another computer to save time from
reconfiguring the open soft-keys on the Tablet.

1. Click the  Save As button. The Save As window appears.

2. Select the save location of the file.
3. Enter the name of the file.

4. Click  Save. The Hot-Key configuration file is saved as .QMP.



Qwizdom Tools 162

Qwizdom Connect 2010

Importing a Hot-Key Configuration File
1. Click the  Import button. The Open window appears.
2. Select the Hot-Key configuration file you want to import.

3. Click  Open.
4. The configuration file appears, replacing the currently displayed configuration file

in the Hot-Key Manager window.
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16 Troubleshoot

16.1 Installing USB Drivers

Installing the USB Drivers on Vista for the RF Host
You will need to do this procedure twice (because there are two drivers). You can download
the drivers from our Web site. Be sure to extract the files before proceeding.

1. Insert the Qwizdom Connect disc into the computer and make sure the host is
plugged in properly.

2. From the Start menu, go to the Control Panel.
3. Click Hardware and Sound.
4. Click Device Manager.
5. Select View Devices by Type under the View menu.
6. Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and

Unknown or Other Devices.
7. Right-click Qwizdom RF Host and select Update Driver. The installation wizard

opens.
8. Select Browse Computer for Software Driver and click Next.
9. Click Browse.  The Open window appears.
10. Select the USB Drivers folder.
11. Click OK and then Next.
12. When it's done installing, click Close.  Repeat the above steps once more and then

restart your computer.

Installing the USB Drivers on Windows XP for the RF Host
You will need to do this procedure twice (because there are two drivers). You can download
the drivers from our Web site. Be sure to extract the files before proceeding.

1. Insert the Qwizdom Connect disc into the computer and make sure the host is
plugged in properly.

2. From the Start menu, go to the Control Panel or go to Settings and then Control
Panel.

3. Double-click the System icon and click the Hardware tab.
4. Click Device Manager.
5. Select View Devices by Type under the View menu.
6. Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and

Unknown or Other Devices.
7. Right-click the Qwizdom RF Host and select Update Driver. The installation wizard

opens.
8. Select Install from a list or specific location and click Next.
9. Select Include this location in search boxes.
10. Click Browse. The Open window appears.
11. Select the USB Drivers folder.
12. Click OK and then Next.

http://www.qwizdom.com/education/support.php
http://www.qwizdom.com/education/support.php
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13. A prompt appears that says the drivers have not passed the Microsoft Windows
Update testing, click Continue Anyway and then Finish.

14. Repeat the above steps once more and then restart your computer.
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16.2 Retrieving Error Logs

1. Right-click  Qwizdom Tools.

2. Select Utilities.

3. Select View Log Files.

4. The location of the error logs will open.

5. Double-click the available folders (number and names of folder will vary).
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6. Error logs usually start with the number 6 and is a text file. If and when Qwizdom
Technical Support request error logs, this is what needs to be emailed.
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16.3 Uninstalling Software and Hardware

Uninstalling Qwizdom Connect
1. Go to Add/Remove programs in the Control Panel.
2. Search for Qwizdom Connect  and click Remove.
3. The Install Shield wizard opens; follow the instructions.
4. Restart your computer for the changes to take effect.

Uninstalling USB Drivers (RF Host)
If the host is still not initializing after following the steps above, then the hardware needs
to be completely removed and reinstalled.  Follow the steps below.

1. Go to your Control Panel from either your Settings or Start menu.
2. Double-click System and click the Hardware tab or Device Manager tab.  If you go to

the Hardware tab, click Device Manager key.
3. Search for the Qwizdom RF Host under Universal Serial Bus Controllers, Ports, and/or

Other or Unknown Devices.
4. Double-click the file and click the Driver tab.
5. Select Uninstall.
6. Unplug your host after it is uninstalled and go back to the Control Panel.
7. Double-click Add or Remove Programs and search for FTDI Universal Serial Converter

Drivers.
8. When you find it, remove the file.
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